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แผนการจัดการเรียนรู้ รายวิชาเขียนแบบดวยโปรแกรมคอมพิวเตอร รหัสวิชา 30102-2002 หลักสูตร
ประกาศนียบัตรวิชาชีพชั้นสูง พุทธศักราช 2567 ประเภทวิชาอุตสาหกรรม กลุ่มอาชีพอุตสาหกรรมการผลิต  
สาขาวิชาเทคนิคการผลิต จัดทำขึ้นตรงตามเกณฑ์อ้างอิงมาตรฐาน ผลลัพธ์การเรียนรู้ระดับรายวิชา จุดประสงค์
รายวิชา สมรรถนะรายวิชา และคำอธิบายรายวิชา ซึ่งมีแนวทางในการจัดการเรียนรู้โดยการพัฒนาผู้เรียนด้าน
คุณธรรม จริยธรรม คุณลักษณะที่พึงประสงค์ คุณลักษณะตามบรรทัดฐานที่ดีของสังคมและลักษณะบุคคล ด้าน
ความรู้ ด้านทักษะ และด้านความสามารถในการประยุกต์ใช้และความรับผิดชอบ เพื่อมุ่งเน้นให้ผู้เรียนเกิดผล
ลัพธ์การเรียนรู้ในระดับรายวิชาตามที่หลักสูตรกำหนด อีกท้ังการบูรณาการด้านคุณธรรม จริยธรรม คุณลักษณะ
ที่พึงประสงค์และคุณลักษณะตามบรรทัดฐานที่ดีของสังคม เพื่อให้ผู้เรียนเกิดค่านิยม มีความรับผิดชอบตาม
บทบาทหน้าที่ของตนเอง ปฏิบัติตนตามแบบแผน มีเจตคติและกิจนิสัยที่ดีต่อจรรยาบรรณวิชาชีพ  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ข 
 

ลักษณะรายวิชา 
 

หลักสูตร  ประกาศนียบัตรวิชาชีพชั้นสูง  ประเภทวิชา  อุตสาหกรรม  .                                                   
กลุ่มอาชีพ  อุตสาหกรรมการผลิต   สาขาวิชา  เทคนิคการผลิต  . 

รหัส  30102-2002   ชื่อวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์  . 
ทฤษฎี  2  ชั่วโมง/สัปดาห์    ปฏิบัติ  3  ชั่วโมง/สัปดาห์   จำนวน  3  หน่วยกิต 

 
อ้างอิงมาตรฐาน 

มาตรฐานฝมือแรงงาน หนวยงานกรมพัฒนาฝมือแรงงาน รหัส 0920022290802 อาชีพชางเขียนแบบ 
เครื่องกลดวยคอมพิวเตอร ระดับ 2 

ผลลัพธ์การเรียนรู้ระดับรายวิชา  
ประยุกตใชโปรแกรมคอมพิวเตอรเขียนรูปชิ้นสวนเครื่องมือกล สองมติ สามมิติ  ตามมาตรฐานอาชีพ 

ชางเขียนแบบเครื่องกลดวยคอมพิวเตอร ระดับ 2 

จุดประสงค์รายวิชา เพ่ือให้  
1. เขาใจหลักการใชโปรแกรมคอมพิวเตอรชวยในการเขียนแบบเครื่องมือกล  
2. มีทักษะการใชโปรแกรมคอมพิวเตอรสรางรูปชิ้นสวนเครื่องมือกล สองมิติ สามมิติ  
3. มีเจตคติและกิจนิสัยในการทํางานดวยความรับผิดชอบ  มีความประณีต  รอบคอบ  ปลอดภัย  
โดยตระหนักถึงคุณภาพงาน  
4. ประยุกตใชการกําหนดขนาด (Dimension)  พิกัดความเผื่อ  พิกัดงานสวม  สัญลักษณผิวงาน   
กําหนดสัญลักษณ GD&T  ตารางรายการแบบ (List of Part) ตามมาตรฐานการปฏิบัติงาน 

สมรรถนะรายวิชา  
1. ประมวลความรูเกี่ยวกับหลักการใชโปรแกรมคอมพิวเตอรเขียนแบบ  
2. ติดตั้งโปรแกรม  ใชโปรแกรมเขียนรูปชิ้นสวนเครื่องมือกลสามมิติ  ภาพถอดประกอบชิ้นสวน สามมิติ 
Explode View  
3. กําหนดขนาด Dimension  พิกัดความเผื่อ  พิกัดงานสวม  สัญลักษณผิวงาน  กําหนดสัญลักษณ 
GD&T  ตารางรายการแบบ List of Part  
4. ประยุกตใชการเขียนแบบดวยโปรแกรมคอมพิวเตอร พิมพแบบสั ่งงาน ตามมาตรฐานอาชีพ
อุตสาหกรรมการผลิต 

คำอธิบายรายวิชา 
ศึกษาและปฏิบัติเกี ่ยวกับหลักการใชโปรแกรมคอมพิวเตอรเขียนแบบ การติดตั้งโปรแกรม การใช

โปรแกรมเขียนรูปชิ้นสวนเครื่องมือกลสามมิติ แสดงขั้นตอนการประกอบชิ้นสวน  แบบสั่งงาน ภาพฉายมุมที่ 1  
ภาพฉายมุมที่ 3 ภาพตัดเต็ม ภาพตัดครึ่ง ภาพตัดเลื่อนแนว Offset Section  ภาพตัดเฉพาะสวน Broken Out 
Section  ภาพตัดหมุน Revolve Section  ภาพตัดยอสวนความยาว  ภาพชวย Auxiliary View ภาพขยาย
เฉพาะสวน Detail View การกําหนดขนาด Dimension  พิกัดความเผื่อ  พิกัดงานสวม  สัญลักษณ 
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ผิวงาน  กําหนดสัญลักษณ GD&T  ตารางรายการแบบ List of Part  ภาพ ประกอบสามมิติ  ภาพถอดประกอบ
ชิ้นสวนสามมิติ Explode View  พิมพแบบสั่งงาน  ปฏิบัติงานอยางมีระเบียบแบบแผน 
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มาตรฐานอาชีพ 
 

หน่วยงานรับรองมาตรฐานอาชีพ  หน่วยงานกรมพัฒนาฝีมือแรงงาน รหัส 0920022290802. 
มาตรฐานอาชีพ  สาขาวิชาชีพ                    -                             . 

อาชีพ  ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ  2  . 
 

หน่วยสมรรถนะ สมรรถนะย่อย 
เกณฑ์การปฏิบัติงาน วิธีประเมิน 

รหัส คำอธิบาย รหัส คำอธิบาย 
รหัส 

0920022 
290802 

มีความรู้ ทักษะและมีความพร้อมทั้ง 
ด ้านร ่างกาย จ ิตใจ ตลอดจนมี
ทัศนคติที ่ดีต่อการประกอบอาชีพ
ช ่ า ง เข ี ยนแบบเคร ื ่ อ งกลด ้ ว ย
คอมพิวเตอร์และสามารถปฏิบัติงาน
ได้ ดังนี้ เขียนแบบสั่งงานการผลิต
โดยใช ้ โปรแกรม cad ได ้อย ่าง
ถูกต้อง ,เขียนแบบภาพประกอบ
สองมิติโดยใช้โปรแกรม cad ได้ ,
สร้างตารางรายงานตารางรายการ
วัสดุและแสดงหมายเลขชิ้นงานได้ ,
พิมพ์แบบงานออกทางเครื่องพิมพ์
ได้ ,สามารถนำความรู้หรือทักษะไป
ใช้ในการปฏิบัติงานหรือพัฒนางาน
ที่มีประสิทธิภาพมากขึ้น 

09209 
20401 

ทฤษฎีเครื ่องมือกล งานวัดละเอียด
และการอ่าน - เขียนแบบเครื่องกล 

1.1 ศึกษา ทบทวนเกี่ยวกับทฤษฎีเครื่องมือกล 
เช่นการใช้เครื่องกลึงเครื่องใส , เครื่องเจาะ และ 
เครื่องกัด เป็นต้น 
1.2 ศึกษา ทบทวนเกี่ยวกับเครื่องมือวัดละเอียด 
เช่นไมโครมิเตอร์, เวอร์เนียร์คาลิเปอร์, ไฮเกจ 
เป็นต้น 
1.3 ศึกษา ทบทวนเกี่ยวกับการอ่าน -เขียน 
แบบเครื่องกลเช่น เส้น, การฉาย,มาตราส่วน 
เป็นต้น 

1. ประเมินตามความรู้
ความสามารถของผู้เรียน 
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หน่วยสมรรถนะ สมรรถนะย่อย 
เกณฑ์การปฏิบัติงาน วิธีประเมิน 

รหัส คำอธิบาย รหัส คำอธิบาย 
รหัส 

0920022 
290802 

มีความรู้ ทักษะและมีความพร้อมทั้ง 
ด ้านร ่างกาย จ ิตใจ ตลอดจนมี
ทัศนคติที ่ดีต่อการประกอบอาชีพ
ช ่ า ง เข ี ยนแบบเคร ื ่ อ งกลด ้ ว ย
คอมพิวเตอร์และสามารถปฏิบัติงาน
ได้ ดังนี้ เขียนแบบสั่งงานการผลิต
โดยใช้โปรแกรม cad ได้อย่าง 
ถูกต้อง ,เขียนแบบภาพประกอบ
สองมิติโดยใช้โปรแกรม cad ได้ ,
สร้างตารางรายงานตารางรายการ
วัสดุและแสดงหมายเลขชิ้นงานได้ ,
พิมพ์แบบงานออกทางเครื่องพิมพ์
ได้ ,สามารถนำความรู้หรือทักษะไป
ใช้ในการปฏิบัติงานหรือพัฒนางาน
ที่มีประสิทธิภาพมากขึ้น 

09209 
20402 

การเขียนแบบสั่งงานการผลิต 2.1 ศึกษาและฝึกปฏิบัติการเขียนแบบสั่งงาน 
(Details Drawing) โดยกำหนดรายละเอียดที่ 
จำเป็นสำหรับการผลิต เช่น ขนาด ลักษณะผิว, 
ค่าพิกัดความเผื่อ, ภาพตัด, ภาพขยาย เป็นต้น 

1. ประเมินตามความรู้
ความสามารถของผู้เรียน 
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หน่วยสมรรถนะ สมรรถนะย่อย 
เกณฑ์การปฏิบัติงาน วิธีประเมิน 

รหัส คำอธิบาย รหัส คำอธิบาย 
รหัส 

0920022 
290802 

มีความรู้ ทักษะและมีความพร้อมทั้ง 
ด ้านร ่างกาย จ ิตใจ ตลอดจนมี
ทัศนคติที ่ดีต่อการประกอบอาชีพ
ช ่ า ง เข ี ยนแบบเคร ื ่ อ งกลด ้ ว ย
คอมพิวเตอร์และสามารถปฏิบัติงาน
ได้ ดังนี้ เขียนแบบสั่งงานการผลิต
โดยใช้โปรแกรม cad ได้อย่าง 
ถูกต้อง ,เขียนแบบภาพประกอบ
สองมิติโดยใช้โปรแกรม cad ได้ ,
สร้างตารางรายงานตารางรายการ
วัสดุและแสดงหมายเลขชิ้นงานได้ ,
พิมพ์แบบงานออกทางเครื่องพิมพ์
ได้ ,สามารถนำความรู้หรือทักษะไป
ใช้ในการปฏิบัติงานหรือพัฒนางาน
ที่มีประสิทธิภาพมากขึ้น 

09209 
20403 

การเขียนแบบภาพประกอบ 2 มิติ 3.1 ศึกษาและฝึกปฏิบัติการเขียนแบบ 
ภาพประกอบ 2 มิติ (2 D Assembly 
Drawing) โดยใช้โปรแกรม Cad 

1. ประเมินตามความรู้
ความสามารถของผู้เรียน 
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หน่วยสมรรถนะ สมรรถนะย่อย 
เกณฑ์การปฏิบัติงาน วิธีประเมิน 

รหัส คำอธิบาย รหัส คำอธิบาย 
รหัส 

0920022 
290802 

มีความรู้ ทักษะและมีความพร้อมทั้ง 
ด ้านร ่างกาย จ ิตใจ ตลอดจนมี
ทัศนคติที ่ดีต่อการประกอบอาชีพ
ช ่ า ง เข ี ยนแบบเคร ื ่ อ งกลด ้ ว ย
คอมพิวเตอร์และสามารถปฏิบัติงาน
ได้ ดังนี้ เขียนแบบสั่งงานการผลิต
โดยใช้โปรแกรม cad ได้อย่าง 
ถูกต้อง ,เขียนแบบภาพประกอบ
สองมิติโดยใช้โปรแกรม cad ได้ ,
สร้างตารางรายงานตารางรายการ
วัสดุและแสดงหมายเลขชิ้นงานได้ ,
พิมพ์แบบงานออกทางเครื่องพิมพ์
ได้ ,สามารถนำความรู้หรือทักษะไป
ใช้ในการปฏิบัติงานหรือพัฒนางาน
ที่มีประสิทธิภาพมากขึ้น 

09209 
20404 

การสร้างตารางรายการ ตารางวัสดุ 
และการแสดงหมายเลขชิ้นงาน 

4.1 ฝึกปฏิบัติการสร้างตารางรายการ (Title 
Block ),ตารางรายการวัสดุ (Parts List) และ 
การแสดงหมายเลขชิ้นงาน (Part Number) 

1. ประเมินตามความรู้
ความสามารถของผู้เรียน 
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หน่วยสมรรถนะ สมรรถนะย่อย 
เกณฑ์การปฏิบัติงาน วิธีประเมิน 

รหัส คำอธิบาย รหัส คำอธิบาย 
รหัส 

0920022 
290802 

มีความรู้ ทักษะและมีความพร้อมทั้ง 
ด ้านร ่างกาย จ ิตใจ ตลอดจนมี
ทัศนคติที ่ดีต่อการประกอบอาชีพ
ช ่ า ง เข ี ยนแบบเคร ื ่ อ งกลด ้ ว ย
คอมพิวเตอร์และสามารถปฏิบัติงาน
ได้ ดังนี้ เขียนแบบสั่งงานการผลิต
โดยใช้โปรแกรม cad ได้อย่าง 
ถูกต้อง ,เขียนแบบภาพประกอบ
สองมิติโดยใช้โปรแกรม cad ได้ ,
สร้างตารางรายงานตารางรายการ
วัสดุและแสดงหมายเลขชิ้นงานได้ ,
พิมพ์แบบงานออกทางเครื่องพิมพ์
ได้ ,สามารถนำความรู้หรือทักษะไป
ใช้ในการปฏิบัติงานหรือพัฒนางาน
ที่มีประสิทธิภาพมากขึ้น 

09209 
20405 

การพิมพ์แบบงานด้วยโปรแกรม 
CAD 

5.1 ศึกษาและฝึกปฏิบัติการใช้โปรแกรม CAD 
ในการพิมพ์แบบงาน เช่น การเลือกเครื่องพิมพ์ 
การเลือกขนาดของกระดาษ การกำหนดมาตรา 
การกำหนดขอบเขตของการพิมพ์ รูปแบบใน 
การพิมพ์ (สี -ขาวดำ) เป็นต้น 

1. ประเมินตามความรู้
ความสามารถของผู้เรียน 
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ตารางวิเคราะห์หน่วยการเรียนรู้ 
 

 

ผลลัพธ์การเรียนรู้ระดับรายวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์.           
 

งานหลัก งานย่อย สมรรถนะย่อย ความรู้ในการปฏิบัติงาน ทักษะในการปฏิบัติงาน 
1. ความรู้พื้นในการใช้โปรแกรม
คอมพิวเตอร์ช่วยเขียนแบบ 

1.1 คอมพิวเตอร์ช่วยออกแบบ 
(Computer Aided Design: 
CAD) 
1.2 จุดมุ่งหมายของคอมพิวเตอร์
ช่วยในการออกแบบ 
1.3 กระบวนการออกแบบ 
1.4 การประยุกต์ใช้คอมพิวเตอร์
ช่วยออกแบบ  
1.5 บทสรุป  
 

1. ให้นิยามคอมพิวเตอร์ในการออกแบบ
เขียนแบบได ้
2. เข้าใจเกี่ยวจุดมุ่งหมายของคอมพิวเตอร์
ช่วยในการออกแบบ 
3. ประยุกต์ใช้คอมพิวเตอร์ช่วยออกแบบ
ได ้
 
 

1. บอกนิยามของคอมพิวเตอร์ในการออกแบบ
หรือเขียนแบบ 
2. บอกจุดมุ่งหมายของคอมพิวเตอร์ช่วยใน
การออกแบบ 
3. เข้าใจการประยุกต์ใช้คอมพิวเตอร์ช่วย
ออกแบบ 
 

1. กำหนดจุดมุ่งหมายในการใช้
คอมพิวเตอร์ช่วยในงานออกแบบได้ 

2. กำหนดกระบวนการออกแบบได้ 
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ผลลัพธ์การเรียนรู้ระดับรายวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์.           
 

งานหลัก งานย่อย สมรรถนะย่อย ความรู้ในการปฏิบัติงาน ทักษะในการปฏิบัติงาน 
2 . ก า ร ใ ช ้ ง า น โ ป ร แ ก ร ม 
SolidWorks  

1.ชุดแถบเครื่องมือองค์ประกอบ
ของโปรแกรม 
2.ไฟล์ (File) สำหรับโปรแกรม 
solid works 
3. ตั้งค่าเบื้องต้นก่อนการใช้งาน 
4.มุมมองของวัตถุในโปรแกรม 
solid works 

1.วิธีการเปิดโปรแกรม Solid Works  
2. บอกข้อแตกต่างของไอคอน  
(Icon) ชุดแถบเครื่องมือ Part,  
Assembly, Drawingและ  
Presentation 
3. ส่วนประกอบบนหน้าจอโปรแกรม 
solid works  
4. การจัดการไฟล์ (File) การสร้าง 
แบบงาน 
ใหม่ (New) การเปิดไฟล์ (Open)  
การบันทึกไฟล์ (Save) การปิดไฟล์ 
แบบงาน (Close) และการออก  
(Exit) โปรแกรมSolid Works  

1. รู้และอธิบายการเปิดโปรแกรม Solid 
Works 
2. รู้และอธิบายข้อแตกต่างของไอคอน 
(Icon) ชุดแถบเครื่องมือ Part, 
Assembly, Drawing และ 
Presentation 
3. รู้และอธิบายส่วนประกอบบนหน้าจอ 
โปรแกรม solid works  
4. รู้และวิเคราะห์การจัดการไฟล์ (File) 
การสร้างแบบงานใหม่ (New) การเปิด 
ไฟล์ (Open) การบันทึกไฟล์ (Save) 
การปิดไฟล์แบบงาน (Close) และการ 
ออก (Exit) โปรแกรม Solid Works 
 

1.ทักษะการใช้ชุดแถบเครื่องมือ 
Part, Assembly, Drawing 
และ Presentation 
2. ทักษะการใช้งาน 
ส่วนประกอบบนหน้าจอ 
โปรแกรม solid works  
3. ทักษะการจัดการไฟล์ (File) 
การสร้างแบบงานใหม่ (New) 
การเปิดไฟล์ (Open) การ 
บันทึกไฟล์ (Save) การปิดไฟล์ 
แบบงาน 

 
 
 
 
 
 
 
 



ฎ 
 

 
 

ผลลัพธ์การเรียนรู้ระดับรายวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์.           
 

งานหลัก งานย่อย สมรรถนะย่อย ความรู้ในการปฏิบัติงาน ทักษะในการปฏิบัติงาน 
3.การเขียนแบบภาพ 2 มิติ 1. เขียนเส้นร่าง (Sketch)2 มิต ิ

2. ชุดคำสั่งเขียนเส้นร่าง 
   (Sketch) 2 มิต ิ
3. ขั้นตอนพื้นฐานการสร้าง 
   ภาพ 2 มิติ (Basic 2D Sketch) 
4. การกำหนดความสัมพันธ์ 
   ของเส้น (Add Relations) 
5. รูปแบบการใช้ตัวช่วยใน 
   การปรับแต่งภาพ (Sketch 
   Entities) 2 มิต ิ
6. การสร ้างสำเนาภาพ 2มิติ  
(Sketch Patte) 

1. คำสั ่งในการร่างเส้น (Sketch)      
2 มิต ิ
2. การสร้างเส้นตรง (Line), การ
สร้างวงกลม (Circle), การสร้างวงรี 
(Ellipse), การสร้างเส้นโค้ง (Arc), 
การสร้างสี่เหลี่ยม (Rectangle), การ
เจาะช่อง (Slot), การสร้างหลาย
เหลี่ยม(Polygon) 
3. กำหนดความสัมพันธ ์ของเส้น 
(Add Relations) 
4. การใช้ตัวช่วยในการปรับแต่งภาพ 
(Sketch Entities) 2 มิต ิ
5. การใช้ตัวช่วยในการสร้างสำเนา
ภาพ 2 มิติ (Sketch Pattern) 

1.รู้และอธิบายหลักการและชุดคำสั่งใน
การร่างเส้น (Sketch) 2 มิต ิ
2. รู ้และอธิบายชุดคำสั ่งเขียนเส้นร่าง 
(Sketch)2 มิต ิ
3. รู้และอธิบายการกำหนดความสัมพันธ์
ของเส้น(Add Relations) 
4. ร ู ้และอธิบายการใช้งาน (Sketch 
Entities) 
2 มิติ และ (Sketch Pattern) 

1. ทักษะในการสร้างเส้นตรง 
(Line), การสร้างวงกลม (Circle), 
การสร้างวงรี (Ellipse), การสร้าง 
เส้นโค้ง (Arc), การสร้างสี่เหลี่ยม 
(Rectangle), การเจาะช่อง 
(Slot), การสร้างหลายเหลี่ยม 
(Polygon) 
2.ทักษะการนำไปใช้ความสัมพันธ์ 
ของเส้น (Add Relations) 
3. ทักษะการใช้คำสั่งช่วย 
(Sketch Entities) 2 มิติ และ 
(Sketch Pattern) 
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ผลลัพธ์การเรียนรู้ระดับรายวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์.           
 

งานหลัก งานย่อย สมรรถนะย่อย ความรู้ในการปฏิบัติงาน ทักษะในการปฏิบัติงาน 
4.การกำหนดขนาด 1. สร้างภาพ 3 มิติ ด้วยแถบ 

เครื่องมือมาตรฐาน (Feature 
Toolbars) 
2.การสร้างเนื้อวัตถุด้วยกลุ่ม 
คำสั่ง (Modify & Pattern 
Feature Toolbars) 
3. ปรับแต่งภาพ 3 มิติด้วย 
กลุ่มคำสั่ง Modify & 
Pattern Feature Toolbars) 

1. หน้าที่และการเรียกใช้แถบ 
เครื่องมือมาตรฐาน (Feature 
Toolbars) และ (Modify & Pattem 
Feature Toolbars) 
2. สร้างเนื้อวัตถุด้วยกลุ่มคำสั่ง 
Feature Toolbars เช่น (Extrude, 
Revolve, Sweep, Loft, Curves, 
Rib) 
3. สร้างเนื้อวัตถุด้วยกลุ่มคำสั่ง 
Modify & Pattern Feature 
Toolbars เช่น Hole, Fillet, 
Chamfer, Shell, Thread, offset 
Rectangular Pattern Circular 
Pattern, และคำสั่ง Mirror 

1. รู้หน้าที่และการเรียกใช้แถบเครื่องมือ
มาตรฐาน 

(Feature Toolbars) และ (Modify & 
Pattern 

Feature Toolbars) 
2. รู้และอธิบายการสร้างเนื้อวัตถุด้วย

กลุ่มคำสั่ง 
(Feature Toolbars) และ (Modify & 

Pattern 
Feature Toolbars) 

1. แสดงการใช้ทักษะในการสร้าง 
เนื้อวัตถุด้วยกลุ่มคำสั่ง Feature 
Toolbars เช่น (Extrude, 
Revolve, Sweep, Loft, Curves, 
Rib) 
2. แสดงการใช้ทักษะในการสร้าง 
เนื้อวัตถุด้วยกลุ่มคำสั่ง Modify & 
Pattem Feature Toolbars เช่น 
Hole, Fillet, Chamfer, Shell, 
Thread, offset Rectangular 
Pattern Circular Pattern, และ 
คำสั่ง Mirror 
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ผลลัพธ์การเรียนรู้ระดับรายวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์.           
 

งานหลัก งานย่อย สมรรถนะย่อย ความรู้ในการปฏิบัติงาน ทักษะในการปฏิบัติงาน 
5.การเขียนแบบภาพ 3 มิติ 1. การสร้างภาพในแบบ 

สั่งงานงาน (View Layout) 
2. การสร้างแบบฟอร์ม 
กระดาษเขียนแบบ (Drawing 
Template) 
3. ขั้นตอนการสร้างตาราง 
รายการแบบ (Title Block) 
4. การจัดการชุดคำสั่ง 
เกี่ยวกับการสร้างแบบ 
สั่งงาน 

1. สร้างภาพในแบบสั่งงาน (View 
Layout) 
2. สร้างแบบฟอร์มกระดาษเขียน

แบบ 
(Drawing Template) 
3. ขั้นตอนการสร้างตารางรายการ 
แบบ (Title Block) และการแก้ไข 
ตารางรายการแบบ (Edit Title 
Block) รายการวัสดุ (Bill of 
Material), การสร้างภาพฉายมุมมอง 
ที่ 1 
4. ชุดคำสั่งเก่ียวกับการสร้างแบบ 
สั่งงาน(View Layout) 

1. รู้และอธิบายการสร้างภาพในแบบ
สั่งงาน (View 

Layout) 
2. รู้และอธิบายการสร้างแบบฟอร์ม

กระดาษเขียน 
แบบ (Drawing Template) 
3. รู้และอธิบายการสร้างตารางรายการ

แบบ 
(Title Block) และการแก้ไขตาราง

รายการแบบ 
(Edit Title Block) รายการวัสดุ (Bill 

of 
Material), การสร้างภาพฉายมุมมองที่ 

1 
4. รู้และอธิบายเกี่ยวกับชุดคำสั่งแบบ

สั่งงาน 
(View Layout) 

1. ทักษะการนำไปใช้ในการ 
สร้างภาพในแบบสั่งงาน (View 
Layout) 
2. แสดงการใช้ทักษะในการ 
สร้างแบบฟอร์มกระดาษเขียน 
แบบ (Drawing Template) 
3. ทักษะการนำไปใช้งานของ 
ชุดคำสั่งเก่ียวกับการสร้างแบบ 
สั่งงาน(View Layout) 
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ผลลัพธ์การเรียนรู้ระดับรายวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์.           
 

งานหลัก งานย่อย สมรรถนะย่อย ความรู้ในการปฏิบัติงาน ทักษะในการปฏิบัติงาน 
6.การเขียนภาพประกอบและ
ภาพถอดประกอบ 
 

1. รูปแบบการบอกขนาดและเส้น
บอกขนาด (Dimensionstyle) 
2. สร้างอักษรและสัญลักษณ์บอก 
ลักษณะรูปทรง(Feature Notes 
&Text Panel) 
3. ตารางรายการว ัสดุTable 
Commands 

1. เส้นบอกขนาดด้วยคำสั่ง  
Dimension และรูปแบบ 
การบอกขนาด (Dimension style) 
2. การระบุค่าพิกัดความเผื่อ  
(Tolerance) 
3. การระบุความหยาบละเอียดของ 
ผิว (Surface Finish) 
4. การระบุเกณฑ์ความคลาดเคลื่อน 
ทางเราขาคณิต (GD&T) 
5. สร้างตารางรายการวัสดุและแก้ไข 
ตารางรายการวัสดุ 
(Bill of Materials) 

1. รู้และอธิบายรูปแบบการบอกขนาด 
โดยใช้คำสั่ง Dimension 
2. รู้และอธิบายการระบุค่าพิกัดความ 
เผื่อความหยาบละเอียดของผิว และ 
เกณฑ์ความคลาดเคลื่อนทางเราขาคณิต 
3. รู้และอธิบายการสร้างตารางรายการ 
วัสดุและแก้ไขตารางรายการวัสดุ 

1. ทักษะการนำไปใช้ในการ 
กำหนดขนาด การบอกขนาด 
จุดอ้างอิงต่าง ๆ ในแบบสั่งงาน 
2. ทักษะการนำไปใช้ในการลง 
รายละเอียดค่าพิกัดความเผื่อ, 
ความหยาบละเอียดของผิว และ 
เกณฑ์ความคลาดเคลื่อนทางเรา 
ขาคณิต ในแบบสั่งงาน 
3.แสดงทักษะในการสร้างตาราง 
รายการวัสดุและแก้ไขตาราง 
รายการวัสดุ 
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ผลลัพธ์การเรียนรู้ระดับรายวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์.           
 

งานหลัก งานย่อย สมรรถนะย่อย ความรู้ในการปฏิบัติงาน ทักษะในการปฏิบัติงาน 
7.การเขียนแบบสั่งงานการผลิต 
 

1. การใช้โปรแกรม 
Solid Works 2023 
ประกอบชิ้นงาน 
2. การใช้คำสั่งเลือก 
ชิ้นงานมาประกอบ 
(Insert 
Component) 
เครื่องมือการ 
ประกอบ Mate 

1. ความหมายของแอสเซมบลีทูล
บาร์ (Assembly 

Toolbar) 
2. แหล่งที่มาของวัตถุคอมโพเนนต์ 

(Component) 
3. ใช้คำสั่งเลือกชิ้นงานมาประกอบ 

Mate Selection 
และ Standard Mate 
4. กำหนดความสัมพันธ์กันโดยใช้

คำสั่ง Coincident, 
P a r a l l e l ,  P e r p e n d i c u l a r , 

Tangent, Concentric 
Lock, Distance, Angle 
5. แก้ไขปรับเปลี่ยนการประกอบและ

การควบคุมทิศทางใน 
การเชื่อมความสัมพันธ์ เช่น 
Flip Mate Alignment 
Aligned, Anti-Aligned Undo 

1. รู้และอธิบายความหมายของการ 
ประกอบชิ้นงาน ที่มาของสกุลไฟล์วัตถุท่ี 
เลือกนำมาประกอบ 
2. รู้และอธิบายคำสั่งเลือกชิ้นงานมา 
ประกอบ Mate Selection 
และ Standard Mate 
3. รู้และอธิบายความสัมพันธ์กันโดยใช้ 
คำสั่ง Coincident, 
Parallel, Perpendicular, Tangent, 
Concentric 
 
Lock, Distance, Angle 
4. รู้และอธิบายการแก้ไขปรับเปลี่ยน

การ 
ประกอบและการควบคุมทิศทางในการ 
เชื่อมความสัมพันธ์ เช่น 
Flip Mate Alignment 
Aligned, Anti-Aligned Undo 

1. ทักษะการนำไปใช้คำสั่งเลือก 
ชิ้นงานมาประกอบ Mate 
Selection 
 
และ Standard Mate 
2. ทักษะการนำไปใช้ 
ความสัมพันธ์กันโดยใช้คำสั่ง 
Coincident, 
 
Parallel, Perpendicular, 
 
Tangent, Concentric 
Lock, Distance, Angle 
3. ทักษะการนำไปใช้แก้ไข 
ปรับเปลี่ยนการประกอบและการ 
ควบคุมทิศทางในการเชื่อม 
ความสัมพันธ์ เช่น 
Flip Mate Alignment 
Aligned, Anti-Aligned Undo 
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ผลลัพธ์การเรียนรู้ระดับรายวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์.           
 

งานหลัก งานย่อย สมรรถนะย่อย ความรู้ในการปฏิบัติงาน ทักษะในการปฏิบัติงาน 
8.การเขียนแบบภาพตัด 
 

1. สร้างภาพถอดประกอบแยก
ชิ้นส่วน(Explode view) 
2. แก้ไขภาพถอดประกอบแยก
ชิ้นส่วน(Explode Step) 
3 .  เข ี ยน เส ้นแสดงแนวถอด
ประกอบ  ( E xp l ode  L i n e 
Sketch) 

1. ถอดประกอบแยกชิ้นส่วน 3 มิติ 
(Explode view) 
2. กำหนดทิศทางและแก้ไขภาพถอด 
ประกอบ 
3. กำหนดเส้นความสัมพันธ์แบบถอด 
ประกอบ (Explode Line Sketch) 

1. รู้และอธิบายการถอดประกอบแยก
ชิ้นส่วน 3 มิต ิ

2. รู้และอธิบายการกำหนดทิศทางและ
แก้ไขภาพถอดประกอบ 

3. รู้และอธิบายความสัมพันธ์แบบถอด 
ประกอบแต่ละชิ้นส่วน 

1. ทักษะการนำไปใช้ในการ 
ถอดประกอบแยกชิ้นส่วน 3 มิติ 
2. ทักษะการแก้ไขปัญหาการ 
กำหนดทิศทางและแก้ไขภาพ 
ถอดประกอบ 
3. ทักษะการนำไปใช้บ่งบอกถึง 
ความสัมพันธ์แบบถอดประกอบ 
แต่ละชิ้นส่วน 

9.การพิมพ์แบบงาน 1. พิมพ์แบบสั่งงาน 
2. ตั้งค่าเครื่องพิมพ์ 
แบบสั่งงานการผลิต 
3. ขั้นตอนการ 
ปรับตั้งค่ากระดาษ 

1. การเปิดใช้คำสั่งในการพิมพ์แบบ
สั่งงาน (Print) 

2. การตั้งค่าเครื่องพิมพ์แบบสั่งงาน 
โดยใช้Document Printer, Print 
Range และ Preview 

3. การเลือกปรับตั้งค่ากระดาษ โดย
ใช้ Page Setup 

1. รู้และอธิบายการพิมพ์แบบงานสั่งงาน 
2. รู้และอธิบายการตั้งค่าเครื่องพิมพ์

แบบสั่งงาน 
3. รู้และอธิบายการเลือกปรับตั้งค่า

กระดาษ 

1. ทักษะการพิมพ์และการตั้ง 
ค่าในการพิมพ์แบบสั่งงาน 

 

 

 



ด 
 

ตารางวิเคราะห์พฤติกรรมการเรียนรู้ 
รหัส  30102-2002   ชื่อวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์. 

ทฤษฎี    2     ชั่วโมง/สัปดาห์    ปฏิบัติ    3     ชั่วโมง/สัปดาห์   จำนวน    3     หน่วยกิต 
 

หน่วยการเรียนรู้ 
ระดับความสามารถที่คาดหวัง จำนวน

ชั่วโมง 
ท/ป 

ร้อยละ
ประเมินผล 

ท/ป 
พุทธิ
พิสัย 

ทักษะ
พิสัย 

จิต
พิสัย 

ประยุกต์
ใช ้

1. ความรู้พื้นในการใช้โปรแกรมคอมพิวเตอร์ช่วยเขียนแบบ K2,K3 S2 A2 Ap2 2/3 10 
2.การใช้งานโปรแกรม SolidWorks  K2,K3 S2 A2 Ap3 6/9 10 
3.การเขียนแบบภาพ 2 มิติ K2,K3 S2 A2 Ap3 8/12 10 
4.การกำหนดขนาด K2,K3 S2 A5 Ap3 6/9 10 
5.การเขียนแบบภาพ 3 มิติ K2,K3 S2 A5 Ap3 2/3 10 
6.การเขียนภาพประกอบและภาพถอดประกอบ K2,K3 S2 A2 Ap3 4/6 10 
7.การเขียนแบบสั่งงานการผลิต K2,K3 S2 A2 Ap3 4/6 10 
8.การเขียนแบบภาพตัด K2,K3 S2 A2 Ap3 4/6 10 
9.การพิมพ์แบบงาน K2,K3 S2 A2 Ap3 4/6 10 

รวมการจัดการเรียนรู้ตลอดภาคเรียน 90 
          ประเมินผลลัพธ์การเรียนรู้ระดับรายวิชา   10 

รวม  100 
 

พุทธิพิสัย ทักษะพิสัย จิตพิสัย 
K1 = ความรู้ ความจำ 
K2 = ความเข้าใจ 
K3 = การนำไปใช้ 
K4 = การวิเคราะห ์
K5 = การประเมินค่า 
K6 = การสร้างสรรค ์
หมายเหตุ ใส่ได้มากกว่า 1 ระดับ 

S1 = เลียนแบบ 
S2 = ทำได้ตามแบบ 
S3 = ทำได้ถูกต้อง 
S4 = ทำได้อย่างต่อเนื่อง 
S5 = ทำได้อย่างเป็นธรรมชาต ิ
 
หมายเหตุ ใส่ระดับท่ีคาดหวังระดบัเดียว 

A1 = รับรู ้
A2 = ตอบสนอง 
A3 = การสร้างคณุค่า 
A4 = จัดระบบคณุค่านยิม 
A5 = การสร้างลักษณะนสิัย 
 
หมายเหตุ ใส่ระดับท่ีคาดหวังระดบัเดียว 

ด้านความสามารถประยุกต์ใช้และรับผิดชอบ 
Ap1 = สามารถปฏิบัติงานตามแบบแผนท่ีกำหนด 
Ap2 = สามารถปฏิบัติงานตามแบบแผน และปรับตัวภายใต้ความเปลี่ยนแปลงท่ีไม่ซับซ้อน 
Ap3 = สามารถวางแผนการปฏิบัติงานท่ีได้รับมอบหมายและแก้ไขปัญหาการปฏบิัติงานท่ีไมอ่ยู่ภายใต้การควบคุมในบางเรือ่ง โดยประยุกต์ใช้ความรู้

ทักษะทางวิชาชีพ เทคโนโลยีสารสนเทศและการสื่อสาร 
Ap4 = สามารถวางแผนการปฏิบัติงานท่ีรับผิดชอบ ปรับตัวและแก้ไขปัญหาการปฏิบัติงานท่ีไม่คุ้นเคยหรือซับซอ้นและเป็นนามธรรมโดยประยุกตใ์ช้

ความรู้ ทักษะทางวิชาชีพ เทคโนโลยีสารสนเทศและการสื่อสาร 
Ap5 = สามารถประยุกต์ใช้ความรู้ ทักษะทางวิชาชีพ เทคโนโลยีสารสนเทศและการสื่อสารในการวางแผนแก้ไขปัญหาและพัฒนานวัตกรรมตามสาย

อาชีพ 
 
หมายเหตุ ใส่ระดับท่ีคาดหวังระดบัเดียว 
 



ต 
 

 
หน่วยการเรียนรู้ 

รหัส  30102-2002   ชื่อวิชา  เขียนแบบด้วยโปรแกรมคอมพิวเตอร์. 
ทฤษฎี    2     ชั่วโมง/สัปดาห์    ปฏิบัติ    3     ชั่วโมง/สัปดาห์   จำนวน    3     หน่วยกิต 

 

สัปดาห์ที่ หน่วยการเรียนรู้ 
เวลาเรียน (ชม.) 

ทฤษฎี ปฏิบัติ รวม 
1 ความรู้พื้นในการใช้โปรแกรมคอมพิวเตอร์ช่วยเขียนแบบ 2 3 5 
2 การใช้งานโปรแกรม SolidWorks  2 3 5 
3 การเขียนแบบภาพ 2 มิติ 2 3 5 

4-5 การกำหนดขนาด 4 6 10 
6-7 การเขียนแบบภาพ 3 มิติ 4 6 10 
8-9 การเขียนภาพประกอบและภาพถอดประกอบ 4 6 10 

10-11 การเขียนแบบสั่งงานการผลิต 4 6 10 
12-13 การเขียนแบบภาพตัด 4 6 10 
14-15 การพิมพ์แบบงาน 4 6 10 

รวม 30 45 75 
 
 



 

แผนการจัดการเรียนรู้ที่  1 หน่วยที่ 1 
สอนครั้งที ่1-4 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ คอมพิวเตอร์ช่วยในการออกแบบ ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

1. ให้นิยามคอมพิวเตอร์ในการออกแบบเขียนแบบได้ 
2. เข้าใจเกี่ยวจุดมุ่งหมายของคอมพิวเตอร์ช่วยในการออกแบบ 
3. ประยุกต์ใช้คอมพิวเตอร์ช่วยออกแบบได้ 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 2.1 มาตรฐานอาชีพ มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน รหัส 0920082091203 
อาชีพช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 ประกอบด้วยหน่วยสมรรถนะดังนี้ 
  0920920401 การติดตั้งโปรแกรม CAD และการจัดการข้อมูล 
  0920920402 ความรู้เบื้องต้นเกี่ยวกับการอ่านและเขียนแบบเครื่องกล 
  0920920403 การเขียนแบบ 2 มิติ 
  0920920404 การสร้างตารางรายการ (Title Block) 
  0920920405 การพิมพ์แบบงานด้วยโปรแกรม CAD 
  0920920406 การบำรุงรักษาเครื่องคอมพิวเตอร์ และอุปกรณ์ท่ีเกี่ยวข้อง 
  1) เกณฑ์การปฏิบัติงาน : ภาคปฏิบัติผ่านเกณฑ์ร้อยละ 80 
  2) วิธีการประเมิน : การทดสอบภาคความรู้และความสามารถ 
  3) หลักฐานการประเมิน (Performance Evidence) : แบบประเมินภาคปฏิบัติ 
  4) หลักฐานความรู้ (Knowledge Evidence) : แบบประเมินภาคความรู้ 
การทดสอบความสามารถ 
 การทดสอบความรูและความสามารถที่จำเป็นจะตองนําไปใชในการปฏิบัติงานอย่างถูกตอง ตามหลัก
วิชาการ โดยใชข้อสอบแบบปรนัย 4 ตัวเลือก จำนวน 5 ขอ ใชเวลาในการทดสอบ 1 ชั่วโมง (60 นาที) คิดเป็น
รอ้ยละ 20 ของคะแนนทั้งหมด 
การทดสอบความสามารถ  
 เป็นการทดสอบความสามารถที ่เก ิดจากการสะสมประสบการณจนเกิดความชํานาญเพียงพอ             
ที่จะปฏิบัติงานได้อย่างมีคุณภาพและมีทัศนคติในการทำงาน ตามขอกำหนดของมาตรฐานฝมือแรงงาน
แห่งชาติ ซึ่งในแบบทดสอบจะวัดประเมิน การใชเครื่องมือ อุปกรณ์การทำงานที่ถูกตองตามขั้นตอน ประหยัด 
ปลอดภัย และเสร็จทันตามเวลาที่กำหนด โดยลักษณะของแบบทดสอบจะเป็นการทดสอบทักษะฝมือโดยให้  
ผู้เขารับการทดสอบ ปฏิบัติงานตามรูปแบบและกฎเกณฑในวิธีการทดสอบมาตรฐานฝมือแรงงานแหงชาติ   
สาขาอาชีพช่างเทคนิคเขียนแบบเครื่องกล ระดับ 1 เริ่มตั้งแต่การสเก็ตช (Sketch) แบบงานจากชิ้นงานจริง 
และการเขียนแบบดด้วยโปรแกรมคอมพิวเตอร์ (ไม่จํากัดโปรแกรมที่ใช) ใชเวลาทดสอบทั้งสิ ้น 3 ชั่วโมง      
คิดเป็นร้อย 80 ของคะแนนทั้งหมด 
 2.2 บูรณาการกลุ่มอาชีพ ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 
 
 



3.  สมรรถนะประจำหน่วย 
 3.1 นิยามของคอมพิวเตอร์ในการออกแบบหรือเขียนแบบ 
 3.2 จุดมุ่งหมายของคอมพิวเตอร์ช่วยในการออกแบบ 
 3.3 การประยุกต์ใช้คอมพิวเตอร์ช่วยออกแบบ 
4.  จุดประสงค์การเรียนรู้ 

4.1 ด้านความรู้  ผู้เรียนสามารถ 
4.1.1 บอกนิยามของคอมพิวเตอร์ในการออกแบบหรือเขียนแบบ 
4.1.2 บอกจุดมุ่งหมายของคอมพิวเตอร์ช่วยในการออกแบบ 
4.1.3 เข้าใจการประยุกต์ใช้คอมพิวเตอร์ช่วยออกแบบ 

4.2 ด้านทักษะ ผู้เรียนสามารถ 
  4.2.1 กำหนดจุดมุ่งหมายในการใช้คอมพิวเตอร์ช่วยในงานออกแบบได้ 
  4.2.2 กำหนดกระบวนการออกแบบได้ 

 4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       ประยุกต์ใช้ความรู้เกี่ยวกับคอมพิวเตอร์ช่วยในการออกแบบได้ถูกต้องตามหลักการ 
 4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
  มีความสนใจใฝ่รู้ในการปฏิบัติงาน ซื่อสัตย์ ตรงเวลา รอบคอบ มีระเบียบวินัยในการทำงาน 
และประยุกตใ์ช้ความรู้ตามหลักปรัชญาของเศรษฐกิจพอเพียงได้  
5.  สาระการเรียนรู้   
 5.1 คอมพิวเตอร์ช่วยออกแบบ (Computer Aided Design: CAD) 
 5.2  จุดมุ่งหมายของคอมพิวเตอร์ช่วยในการออกแบบ 
 5.3 กระบวนการออกแบบ 
 5.4 การประยุกต์ใช้คอมพิวเตอร์ช่วยออกแบบ 
6.  กิจกรรมการเรียนรู้ 
 6.1 ขั้นนำเข้าสู่บทเรียน 

 1. ครูผู ้สอนแนะนำจุดมุ่งหมายที่ผู ้เรียนจะได้จากหลักสูตร โดยกำหนดให้ผู ้เรียนทุกคนต้องมี
ความรู้ ความสามารถและมีทักษะในเรื่อง คอมพิวเตอร์ช่วยในการออกแบบ 

 2.  ครูผู้สอนทบทวนความรู้เดิมของผู้เรียนเกี่ยวกับคอมพิวเตอร์ช่วยในการออกแบบให้ผู้เรียน
แสดงความคิดเห็นเกี่ยวกับคอมพิวเตอร์ช่วยในการออกแบบ พร้อมให้ผู้เรียนยกตัวอย่าง 
 3.  ครูผู้สอนชี้ให้เห็นความสำคัญของคอมพิวเตอร์ช่วยในการออกแบบมีต่องานอาชีพ  
 6.2 ขั้นให้เนื้อหาและการสอน 

ครูผู้สอนให้เนื้อหา โดยใช้สื่อนำเสนอ Power Point ประกอบการบรรยาย เรื่อง คอมพิวเตอร์ช่วยในการ
ออกแบบ  

6.3 ขั้นสรุปและการประยุกต์ 
1. ครูผู้สอนและนักศึกษาร่วมกันอภิปรายสรุปเนื้อหา หน่วยการเรียนที่  1 คอมพิวเตอร์ช่วยในการ

ออกแบบ 
2. ให้ผู้เรียนทำแบบฝึกหัด ใบงาน และแบบทดสอบหลังเรียน หน่วยการเรียนที่ 1 เรื่อง คอมพิวเตอร์

ช่วยในการออกแบบ 
3. ครูผู้สอนตรวจประเมินผล แบบฝึกหัด และแบบทดสอบหลังเรียน ใบงาน หน่วยการเรียนที่ 1 เรื่อง คอมพิวเตอร์

ช่วยในการออกแบบ 



7.  ส่ือการเรียนการสอน 
7.1  หนังสือเรียนวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ (SolidWorks) 
7.2  สื่อนำเสนอ Power Point เรื่อง คอมพิวเตอร์ช่วยในการออกแบบ 

8.  กิจกรรมเสนอแนะ / งานที่มอบหมาย  
 ผู้เรียนจัดทำใบงาน และทำกิจกรรมที่กำหนดไว้  
 8.1  แบบฝึกหัดท้ายบทเรียนที่ 1 
 8.2   แบบทดสอบหลังเรียนบทเรียนที่ 1 
9. การวัดและประเมินผล 
 9.1 เครื่องมือประเมิน 
  การสังเกตพฤติกรรมการทำงานกลุ่ม  งานจากแบบฝึกหัด  คะแนนจากการทดสอบ 
 9.2 เกณฑ์การประเมิน 
  ผลรวมของคะแนนจากเครื่องมือประเมินทุกประเภทไม่ต่ำกว่าร้อยละ 60 ถือว่าผ่านเกณฑ์ประเมินผล 
 
 
  



 

แผนการจัดการเรียนรู้ที่  2 หน่วยที่ 2 
สอนครั้งที ่2 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การใช้งานโปรแกรม SolidWorks ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

1. บอกวิธีการเรียกใช้งานโปรแกรมได้  
2. อธิบายพื้นที่การทำงานในโปรแกรมได้  
3. ระบุชื่อและหน้าที่ส่วนประกอบหน้าต่างใช้งานโปรแกรม SolidWorks  
4. บอกวิธีการตั้งค่าก่อนการทำงานได้  
5. ตั้งค่าการกำหนดขนาด (Dimensioning) ได้ 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 2.1 มาตรฐานอาชีพ มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน รหัส 0920082091203 
อาชีพช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 ประกอบด้วยหน่วยสมรรถนะดังนี้ 
  0920920401 การติดตั้งโปรแกรม CAD และการจัดการข้อมูล 
  0920920402 ความรู้เบื้องต้นเกี่ยวกับการอ่านและเขียนแบบเครื่องกล 
  0920920403 การเขียนแบบ 2 มิติ 
  0920920404 การสร้างตารางรายการ (Title Block) 
  0920920405 การพิมพ์แบบงานด้วยโปรแกรม CAD 
  0920920406 การบำรุงรักษาเครื่องคอมพิวเตอร์ และอุปกรณ์ท่ีเกี่ยวข้อง 
  1) เกณฑ์การปฏิบัติงาน : ภาคปฏิบัติผ่านเกณฑ์ร้อยละ 80 
  2) วิธีการประเมิน : การทดสอบภาคความรู้และความสามารถ 
  3) หลักฐานการประเมิน (Performance Evidence) : แบบประเมินภาคปฏิบัติ 
  4) หลักฐานความรู้ (Knowledge Evidence) : แบบประเมินภาคความรู้ 
การทดสอบความสามารถ 
 การทดสอบความรูและความสามารถที่จำเป็นจะตองนําไปใชในการปฏิบัติงานอย่างถูกตอง ตามหลัก
วิชาการ โดยใชข้อสอบแบบปรนัย 4 ตัวเลือก จำนวน 5 ขอ ใชเวลาในการทดสอบ 1 ชั่วโมง (60 นาที) คิดเป็น
รอ้ยละ 20 ของคะแนนทั้งหมด 
การทดสอบความสามารถ  
 เป็นการทดสอบความสามารถที ่เก ิดจากการสะสมประสบการณจนเกิดความชํานาญเพียงพอ             
ที่จะปฏิบัติงานได้อย่างมีคุณภาพและมีทัศนคติในการทำงาน ตามขอกำหนดของมาตรฐานฝมือแรงงาน
แห่งชาติ ซึ่งในแบบทดสอบจะวัดประเมิน การใชเครื่องมือ อุปกรณ์การทำงานที่ถูกตองตามขั้นตอน ประหยัด 
ปลอดภัย และเสร็จทันตามเวลาที่กำหนด โดยลักษณะของแบบทดสอบจะเป็นการทดสอบทักษะฝมือโดยให้  
ผู้เขารับการทดสอบ ปฏิบัติงานตามรูปแบบและกฎเกณฑในวิธีการทดสอบมาตรฐานฝมือแรงงานแหงชาติ   
สาขาอาชีพช่างเทคนิคเขียนแบบเครื่องกล ระดับ 1 เริ่มตั้งแต่การสเก็ตช (Sketch) แบบงานจากชิ้นงานจริง 
และการเขียนแบบดด้วยโปรแกรมคอมพิวเตอร์ (ไม่จํากัดโปรแกรมที่ใช) ใชเวลาทดสอบทั้งสิ ้น 3 ชั่วโมง      
คิดเป็นร้อย 80 ของคะแนนทั้งหมด 
 2.2 บูรณาการกลุ่มอาชีพ ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 



3.  สมรรถนะประจำหน่วย 
3.1 เรียกใช้งานโปรแกรมได้ 
3.2 ตั้งค่าก่อนการทำงานได้ 
3.3 กำหนดขนาด (Dimensioning) ได้ 
3.4 ใช้งานคำสั่งกำหนดขนาด (Smart Dimension) ได้ 

4.  จุดประสงค์การเรียนรู้ 
4.2 ด้านความรู้  ผู้เรียนสามารถ 

4.2.1 บอกวิธีการเรียกใช้งานโปรแกรมได้  
4.2.2 อธิบายพื้นที่การทำงานในโปรแกรมได้  
4.2.3 ระบุชื่อและหน้าที่ส่วนประกอบหน้าต่างใช้งานโปรแกรม SolidWorks  
4.2.4 บอกวิธีการตั้งค่าก่อนการทำงานได้  
4.2.5 ตั้งค่าการกำหนดขนาด (Dimensioning) ได ้

4.2 ด้านทักษะ ผู้เรียนสามารถ 
4.2.1 เรียกใช้งานโปรแกรมได้ 
4.2.2 ตั้งค่าก่อนการทำงานได้ 
4.2.3 ตั้งค่ากำหนดขนาด (Dimensioning) ได้  
4.2.4 ใช้งานคำสั่งกำหนดขนาด (Smart Dimension) ได้ 

 4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       ประยุกต์ใช้ความรู้เกี่ยวกับใช้งานโปรแกรมได้ถูกต้องตามหลักการ 
 4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
  มีความสนใจใฝ่รู้ในการปฏิบัติงาน ซื่อสัตย์ ตรงเวลา รอบคอบ มีระเบียบวินัยในการทำงาน และ
ประยุกตใ์ช้ความรู้ตามหลักปรัชญาของเศรษฐกิจพอเพียงได ้ 
5.  สาระการเรียนรู้   

5.1 ความเป็นมาของโปรแกรม SolidWorks 
5.2 การเรียกใช้งานโปรแกรม 
5.3 พ้ืนที่การทำงานในโปรแกรม 
5.4 ส่วนประกอบหน้าต่างใช้งานโปรแกรม SolidWorks  
5.5 การตั้งค่าก่อนการทำงาน 
5.6 การกำหนดขนาด (Dimensioning) 

6.  กิจกรรมการเรียนรู้ 
 6.1 ขั้นนำเข้าสู่บทเรียน 

 1. ครูผู ้สอนแนะนำจุดมุ่งหมายที่ผู ้เรียนจะได้จากหลักสูตร โดยกำหนดให้ผู ้เรียนทุกคนต้องมี
ความรู้ ความสามารถและมีทักษะในเรื่อง การใช้งานโปรแกรม SolidWorks 

 2.  ครูผู้สอนทบทวนความรู้เดิมของผู้เรียนเกี่ยวกับการใช้งานโปรแกรม SolidWorks ให้ผู้เรียน
แสดงความคิดเห็นเกี่ยวกับการใช้งานโปรแกรม SolidWorks พร้อมให้ผู้เรียนยกตัวอย่าง 
 3.  ครูผู้สอนชี้ให้เห็นความสำคัญของคอมพิวเตอร์ช่วยในการออกแบบมีต่องานอาชีพ  
 6.2 ขั้นให้เนื้อหาและการสอน 



ครูผู ้สอนให้เนื้อหา โดยใช้สื ่อนำเสนอ Power Point ประกอบการบรรยาย เรื ่อง การใช้งานโปรแกรม 
SolidWorks 

6.4 ขั้นสรุปและการประยุกต์ 
4. ครูผู ้สอนและนักศึกษาร่วมกันอภิปรายสรุปเนื ้อหา หน่วยการเรียนที่  2 การใช้งานโปรแกรม 

SolidWorks 
5. ให้ผู้เรียนทำแบบฝึกหัด ใบงาน และแบบทดสอบหลังเรียน หน่วยการเรียนที่ 2 เรื่อง การใช้งาน

โปรแกรม SolidWorks 
6. ครูผู้สอนตรวจประเมินผล แบบฝึกหัด และแบบทดสอบหลังเรียน ใบงาน หน่วยการเรียนที่ 2 เรื่อง การใช้งาน

โปรแกรม SolidWorks 
7.  ส่ือการเรียนการสอน 

7.3  หนังสือเรียนวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ (SolidWorks) 
7.4  สื่อนำเสนอ Power Point เรื่อง การใช้งานโปรแกรม SolidWorks 

8.  กิจกรรมเสนอแนะ / งานที่มอบหมาย  
 ผู้เรียนจัดทำใบงาน และทำกิจกรรมที่กำหนดไว้  
 8.1  แบบฝึกหัดท้ายบทเรียนที่ 2 
 8.2  แบบทดสอบหลังเรียนบทเรียนที่ 2 
9. การวัดและประเมินผล 
 9.1 เครื่องมือประเมิน 
  การสังเกตพฤติกรรมการทำงานกลุ่ม  งานจากแบบฝึกหัด  คะแนนจากการทดสอบ 
 9.2 เกณฑ์การประเมิน 
  ผลรวมของคะแนนจากเครื่องมือประเมินทุกประเภทไม่ต่ำกว่าร้อยละ 60 ถือว่าผ่านเกณฑ์ประเมินผล 
 
  



 

 

แผนการจัดการเรียนรู้ที่  3 หน่วยที่ 3 
สอนครั้งที ่3 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพ 2 มิติ ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

 
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

1. เข้าใจหลักการสร้างสเกตช์ 2 มิติ 
2. ระบุชื่อคำสั่งสร้างสเกตช์ 2 มิติได้ 
3. แสดงขั้นตอนการสร้างสเกตช์ได้ 
4. ใช้งานคำสั่งใน Sketch Tab ได้ 
5. กำหนดความสัมพันธ์ (Add Relation) ได้ 
6. เขียนแบบภาพ 2 มิติได้ 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 2.1 มาตรฐานอาชีพ มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน รหัส 0920082091203 
อาชีพช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 ประกอบด้วยหน่วยสมรรถนะดังนี้ 
  0920920401 การติดตั้งโปรแกรม CAD และการจัดการข้อมูล 
  0920920402 ความรู้เบื้องต้นเกี่ยวกับการอ่านและเขียนแบบเครื่องกล 
  0920920403 การเขียนแบบ 2 มิติ 
  0920920404 การสร้างตารางรายการ (Title Block) 
  0920920405 การพิมพ์แบบงานด้วยโปรแกรม CAD 
  0920920406 การบำรุงรักษาเครื่องคอมพิวเตอร์ และอุปกรณ์ท่ีเกี่ยวข้อง 
  1) เกณฑ์การปฏิบัติงาน : ภาคปฏิบัติผ่านเกณฑ์ร้อยละ 80 
  2) วิธีการประเมิน : การทดสอบภาคความรู้และความสามารถ 
  3) หลักฐานการประเมิน (Performance Evidence) : แบบประเมินภาคปฏิบัติ 
  4) หลักฐานความรู้ (Knowledge Evidence) : แบบประเมินภาคความรู้ 
การทดสอบความสามารถ 
 การทดสอบความรูและความสามารถที่จำเป็นจะตองนําไปใชในการปฏิบัติงานอย่างถูกตอง ตามหลัก
วิชาการ โดยใชข้อสอบแบบปรนัย 4 ตัวเลือก จำนวน 5 ขอ ใชเวลาในการทดสอบ 1 ชั่วโมง (60 นาที) คิดเป็น
รอ้ยละ 20 ของคะแนนทั้งหมด 
การทดสอบความสามารถ  
 เป็นการทดสอบความสามารถที ่เก ิดจากการสะสมประสบการณจนเกิดความชํานาญเพียงพอ             
ที่จะปฏิบัติงานได้อย่างมีคุณภาพและมีทัศนคติในการทำงาน ตามขอกำหนดของมาตรฐานฝมือแรงงาน
แห่งชาติ ซึ่งในแบบทดสอบจะวัดประเมิน การใชเครื่องมือ อุปกรณ์การทำงานที่ถูกตองตามขั้นตอน ประหยัด 
ปลอดภัย และเสร็จทันตามเวลาที่กำหนด โดยลักษณะของแบบทดสอบจะเป็นการทดสอบทักษะฝมือโดยให้  
ผู้เขารับการทดสอบ ปฏิบัติงานตามรูปแบบและกฎเกณฑในวิธีการทดสอบมาตรฐานฝมือแรงงานแหงชาติ   
สาขาอาชีพช่างเทคนิคเขียนแบบเครื่องกล ระดับ 1 เริ่มตั้งแต่การสเก็ตช (Sketch) แบบงานจากชิ้นงานจริง 



และการเขียนแบบดด้วยโปรแกรมคอมพิวเตอร์ (ไม่จํากัดโปรแกรมที่ใช) ใชเวลาทดสอบทั้งสิ ้น 3 ชั่วโมง      
คิดเป็นร้อย 80 ของคะแนนทั้งหมด 
 2.2 บูรณาการกลุ่มอาชีพ ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 
3.  สมรรถนะประจำหน่วย 

3.5 หลักการสร้างสเกตช์ 2 มิติ 
3.6 ชุดคำสั่งสร้างสเกตช์ 2 มิติ 
3.7 การสร้างสเกตช์ 
3.8 การใช้งานคำสั่งใน Sketch Tab 
3.9 การกำหนดความสัมพันธ์ (Add Relation) 
3.10 การเขียนแบบภาพ 2 มิติ 

4.  จุดประสงค์การเรียนรู้ 
4.3 ด้านความรู้  ผู้เรียนสามารถ 

4.3.1 บอกหลักการสร้างสเกตช์ 2 มิติได้  
4.3.2 ระบุชื่อคำสั่งสร้างสเกตช์ 2 มิติได้  
4.3.3 บอกขั้นตอนการสร้างสเกตช์ได้  
4.3.4 ใช้คำสั่งใน Sketch Tab ได้  
4.3.5 กำหนดความสัมพันธ์ (Add Relation) ได้  
4.3.6 เขียนแบบภาพ 2 มิติได้ 

4.3 ด้านทักษะ ผู้เรียนสามารถ 
4.3.1 ใช้งานคำสั่งใน Sketch Tab ได้  
4.3.2 กำหนดความสัมพันธ์ (Add Relation) ได้  
4.3.3 เขียนแบบภาพ 2 มิติได้ 

 4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       ประยุกต์ใช้ความรู้เกี่ยวกับการเขียนแบบภาพ 2 มิต ิได้ถูกต้องตามหลักการ 
 4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
  มีความสนใจใฝ่รู้ในการปฏิบัติงาน ซื่อสัตย์ ตรงเวลา รอบคอบ มีระเบียบวินัยในการทำงาน และ
ประยุกตใ์ช้ความรู้ตามหลักปรัชญาของเศรษฐกิจพอเพียงได ้ 
5.  สาระการเรียนรู้   

5.7 หลักการสร้างสเกตช์ 2 มิติ 
5.8 ชุดคำสั่งสร้างสเกตช์ 2 มิติ 
5.9 ขั้นตอนการสร้างสเกตช์ 
5.10 การใช้งานคำสั่งใน Sketch Tab 
5.11 การกำหนดความสัมพันธ์ (Add Relations) 
5.12 กรณีศึกษาการเขียนภาพแบบ 2 มิต ิ

6.  กิจกรรมการเรียนรู้ 
 6.1 ขั้นนำเข้าสู่บทเรียน 

 1. ครูผู ้สอนแนะนำจุดมุ่งหมายที่ผู ้เรียนจะได้จากหลักสูตร โดยกำหนดให้ผู ้เรียนทุกคนต้องมี
ความรู้ ความสามารถและมีทักษะในเรื่อง การเขียนแบบภาพ 2 มิติ 



 2.  ครูผู้สอนทบทวนความรู้เดิมของผู้เรียนเกี่ยวกับการเขียนแบบภาพ 2 มิติ ให้ผู้เรียนแสดงความ
คิดเห็นเกี่ยวกับการเขียนแบบภาพ 2 มิติ พร้อมให้ผู้เรียนยกตัวอย่าง 
 3.  ครูผู้สอนชี้ให้เห็นความสำคัญของคอมพิวเตอร์ช่วยในการออกแบบมีต่องานอาชีพ  
 6.2 ขั้นให้เนื้อหาและการสอน 

ครูผู้สอนให้เนื้อหา โดยใช้สื่อนำเสนอ Power Point ประกอบการบรรยาย เรื่อง การเขียนแบบภาพ 2 มิติ 
6.5 ขั้นสรุปและการประยุกต์ 

7. ครูผู้สอนและนักศึกษาร่วมกันอภิปรายสรุปเนื้อหา หน่วยการเรียนที่ 3 การเขียนแบบภาพ 2 มิติ  
8. ให้ผู้เรียนทำแบบฝึกหัด ใบงาน และแบบทดสอบหลังเรียน หน่วยการเรียนที่ 3 เรื่อง การเขียนแบบ

ภาพ 2 มิติ 
9. ครูผู้สอนตรวจประเมินผล แบบฝึกหัด และแบบทดสอบหลังเรียน ใบงาน หน่วยการเรียนที่ 3 เรื่อง การเขียน

แบบภาพ 2 มิติ 
7.  ส่ือการเรียนการสอน 

7.5  หนังสือเรียนวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ (SolidWorks) 
7.6  สื่อนำเสนอ Power Point เรื่อง การเขียนแบบภาพ 2 มิติ 

8.  กิจกรรมเสนอแนะ / งานที่มอบหมาย  
 ผู้เรียนจัดทำใบงาน และทำกิจกรรมที่กำหนดไว้  
 8.1  แบบฝึกหัดท้ายบทเรียนที่ 3 
 8.2  แบบทดสอบหลังเรียนบทเรียนที่ 3  
9. การวัดและประเมินผล 
 9.1 เครื่องมือประเมิน 
  การสังเกตพฤติกรรมการทำงานกลุ่ม งานจากแบบฝึกหัด  คะแนนจากการทดสอบ 
 9.2 เกณฑ์การประเมิน 
  ผลรวมของคะแนนจากเครื่องมือประเมินทุกประเภทไม่ต่ำกว่าร้อยละ 60 ถือว่าผ่านเกณฑ์ประเมินผล 
 
 
 
 
 
 
 
 

 

 

 

 

 



 

แผนการจัดการเรียนรู้ที่  4 หน่วยที่ 4 
สอนครั้งที ่4-5 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การกำหนดขนาด ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 
 1. แสดงการสร้างสเกตช์ขั้นตอนการกำหนดขนาดด้วยคำสั่ง Smart Dimension ได ้
 2. กำหนดความหยาบละเอียดผิวงาน และกำหนดขนาดด้วยคำสั่ง Smart Dimension ได้ 
 3. ระบุพิกัดความเผื่อ และระบุค่าความคลาดเคลื่อนทางเรขาคณิตได้  
 4. กำหนดขนาด ระบบพิกัดความเผื่อ 
 5. กำหนดการใช้งานคำสั่งกำหนดขนาด และระบบงานสวมได้ 
2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 2.1 มาตรฐานอาชีพ มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน รหัส 0920082091203 
อาชีพช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 ประกอบด้วยหน่วยสมรรถนะดังนี้ 
  0920920401 การติดตั้งโปรแกรม CAD และการจัดการข้อมูล 
  0920920402 ความรู้เบื้องต้นเกี่ยวกับการอ่านและเขียนแบบเครื่องกล 
  0920920403 การเขียนแบบ 2 มิติ 
  0920920404 การสร้างตารางรายการ (Title Block) 
  0920920405 การพิมพ์แบบงานด้วยโปรแกรม CAD 
  0920920406 การบำรุงรักษาเครื่องคอมพิวเตอร์ และอุปกรณ์ท่ีเกี่ยวข้อง 
  1) เกณฑ์การปฏิบัติงาน : ภาคปฏิบัติผ่านเกณฑ์ร้อยละ 80 
  2) วิธีการประเมิน : การทดสอบภาคความรู้และความสามารถ 
  3) หลักฐานการประเมิน (Performance Evidence) : แบบประเมินภาคปฏิบัติ 
  4) หลักฐานความรู้ (Knowledge Evidence) : แบบประเมินภาคความรู้ 
การทดสอบความสามารถ 
 การทดสอบความรูและความสามารถที่จำเป็นจะตองนําไปใชในการปฏิบัติงานอย่างถูกตอง ตามหลัก
วิชาการ โดยใชข้อสอบแบบปรนัย 4 ตัวเลือก จำนวน 5 ขอ ใชเวลาในการทดสอบ 1 ชั่วโมง (60 นาที) คิดเป็น
รอ้ยละ 20 ของคะแนนทั้งหมด 
การทดสอบความสามารถ  
 เป็นการทดสอบความสามารถที ่เก ิดจากการสะสมประสบการณจนเกิดความชํานาญเพียงพอ             
ที่จะปฏิบัติงานได้อย่างมีคุณภาพและมีทัศนคติในการทำงาน ตามขอกำหนดของมาตรฐานฝมือแรงงาน
แห่งชาติ ซึ่งในแบบทดสอบจะวัดประเมิน การใชเครื่องมือ อุปกรณ์การทำงานที่ถูกตองตามขั้นตอน ประหยัด 
ปลอดภัย และเสร็จทันตามเวลาที่กำหนด โดยลักษณะของแบบทดสอบจะเป็นการทดสอบทักษะฝมือโดยให้  
ผู้เขารับการทดสอบ ปฏิบัติงานตามรูปแบบและกฎเกณฑในวิธีการทดสอบมาตรฐานฝมือแรงงานแหงชาติ   
สาขาอาชีพช่างเทคนิคเขียนแบบเครื่องกล ระดับ 1 เริ่มตั้งแต่การสเก็ตช (Sketch) แบบงานจากชิ้นงานจริง 
และการเขียนแบบดด้วยโปรแกรมคอมพิวเตอร์ (ไม่จํากัดโปรแกรมที่ใช) ใชเวลาทดสอบทั้งสิ ้น 3 ชั่วโมง      
คิดเป็นร้อย 80 ของคะแนนทั้งหมด 
 2.2 บูรณาการกลุ่มอาชีพ ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 



3.  สมรรถนะประจำหน่วย 
3.11 การใช้งานคำสั่งกำหนดขนาด 
3.12 ขั้นตอนการกำหนดขนาดด้วยคำสั่ง Smart Dimension 
3.13 การระบุพิกัดความเผื่อ 
3.14 การระบุพิกัดความคลาดเคลื่อน 
3.15 การระบุค่าความคลาดเคลื่อนทางเรขาคณิต 
3.16 การเลือกใช้ระบบงานสวม 

4.  จุดประสงค์การเรียนรู้ 
4.4 ด้านความรู้  ผู้เรียนสามารถ 

4.4.1 บอกขั้นตอนการสร้างสเกตช์และการกำหนดขนาดด้วยคำสั่ง Smart Dimension ได ้
4.4.2 กำหนดความหยาบละเอียดผิวงานและกำหนดขนาดด้วยคำสั่ง Smart Dimension ได้  
4.4.3 ระบุพิกัดความเผื่อ และระบุค่าความคลาดเคลื่อนทางเรขาคณิตได้ 
4.4.4 เข้าใจเกี่ยวกับการกำหนดขนาด ระบบพิกัดความเผื่อ  
4.4.5 เลือกใช้ใช้งานคำสั่งกำหนดขนาด และระบบงานสวมได้ 

 4.2 ด้านทักษะ ผู้เรียนสามารถ 
4.3.4 กำหนดขนาดด้วยคำสั่ง Smart Dimension ได ้
4.3.5 กำหนดความหยาบละเอียดผิวงานได้ 
4.3.6 กำหนดขนาด ระบบพิกัดความเผื่อได้ 

 4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       ประยุกต์ใช้ความรู้เกี่ยวกับการกำหนดขนาด ได้ถูกต้องตามหลักการ 
 4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
  มีความสนใจใฝ่รู้ในการปฏิบัติงาน ซื่อสัตย์ ตรงเวลา รอบคอบ มีระเบียบวินัยในการทำงาน และ
ประยุกตใ์ช้ความรู้ตามหลักปรัชญาของเศรษฐกิจพอเพียงได ้ 
 
 
5.  สาระการเรียนรู้   

5.13 การใช้งานคำสั่งกำหนดขนาด (Smart Dimension) 
5.14 การระบุพิกัดความเผื่อ (Tolerancing)  
5.15 ระบบงานสวม  
5.16 การกำหนดความหยาบละเอียดผิวงาน (Surface Finish) 
5.17 การระบุค่าความคลาดเคลื่อนทางเรขาคณิต (Geometric Dimensioning and Tolerance 

GD&T) 
6.  กิจกรรมการเรียนรู้ 
 6.1 ขั้นนำเข้าสู่บทเรียน 

 1. ครูผู ้สอนแนะนำจุดมุ่งหมายที่ผู ้เรียนจะได้จากหลักสูตร โดยกำหนดให้ผู ้เรียนทุกคนต้องมี
ความรู้ ความสามารถและมีทักษะในเรื่อง การกำหนดขนาด 

 2.  ครูผู้สอนทบทวนความรู้เดิมของผู้เรียนเกี่ยวกับการกำหนดขนาด ให้ผู้เรียนแสดงความคิดเห็น
เกี่ยวกับการกำหนดขนาด พร้อมให้ผู้เรียนยกตัวอย่าง 
   3.  ครูผู้สอนชี้ให้เห็นความสำคัญของคอมพิวเตอร์ช่วยในการออกแบบมีต่องานอาชีพ  



 6.2 ขั้นให้เนื้อหาและการสอน 
ครูผู้สอนให้เนื้อหา โดยใช้สื่อนำเสนอ Power Point ประกอบการบรรยาย เรื่อง การกำหนดขนาด 

6.6 ขั้นสรุปและการประยุกต์ 
10. ครูผู้สอนและนักศึกษาร่วมกันอภิปรายสรุปเนื้อหา หน่วยการเรียนที่ 4 การกำหนดขนาด  
11. ให้ผู้เรียนทำแบบฝึกหัด ใบงาน และแบบทดสอบหลังเรียน หน่วยการเรียนที่ 4 เรื่อง การกำหนด

ขนาด 
12. ครูผู้สอนตรวจประเมินผล แบบฝึกหัด และแบบทดสอบหลังเรียน ใบงาน หน่วยการเรียนที่ 4 เรื่อง การกำหนด

ขนาด 
7.  ส่ือการเรียนการสอน 

7.7  หนังสือเรียนวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ (SolidWorks) 
7.8  สื่อนำเสนอ Power Point เรื่อง การกำหนดขนาด 

8.  กิจกรรมเสนอแนะ / งานที่มอบหมาย  
 ผู้เรียนจัดทำใบงาน และทำกิจกรรมที่กำหนดไว้  
 8.1  แบบฝึกหัดท้ายบทเรียนที่ 4 
 8.2  แบบทดสอบหลังเรียนบทเรียนที่ 4 
9. การวัดและประเมินผล 
 9.1 เครื่องมือประเมิน 
  การสังเกตพฤติกรรมการทำงานกลุ่ม งานจากแบบฝึกหัด  คะแนนจากการทดสอบ 
 9.2 เกณฑ์การประเมิน 
  ผลรวมของคะแนนจากเครื่องมือประเมินทุกประเภทไม่ต่ำกว่าร้อยละ 60 ถือว่าผ่านเกณฑ์ประเมินผล 
 
 
  



 

แผนการจัดการเรียนรู้ที่  5 หน่วยที่ 5 
สอนครั้งที ่6-7 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพ 3 มิติ ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

1. บอกชื่อคำสั่งเขียนแบบภาพ 3 มิติได้ 
2. ใช้งานคำสั่งควบคุมมุมมองมาตรฐานของชิ้นงานได้ 
3. ใช้งานคำสั่งของโหมดฟีทเจอร์ได้ 
4. เขียนแบบชิ้นงาน 3 มิติรูปทรงปริซึม (Prism) ได้ 
5. เขียนแบบชิ้นงานล้อสายพาน (Pulley) ได ้
6. เขียนเกลียวเพลาและเกลียวสี่เหลี่ยมคางหมู (Shaft) ได้ 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 2.1 มาตรฐานอาชีพ มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน รหัส 0920082091203 
อาชีพช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 ประกอบด้วยหน่วยสมรรถนะดังนี้ 
  0920920401 การติดตั้งโปรแกรม CAD และการจัดการข้อมูล 
  0920920402 ความรู้เบื้องต้นเกี่ยวกับการอ่านและเขียนแบบเครื่องกล 
  0920920403 การเขียนแบบ 2 มิติ 
  0920920404 การสร้างตารางรายการ (Title Block) 
  0920920405 การพิมพ์แบบงานด้วยโปรแกรม CAD 
  0920920406 การบำรุงรักษาเครื่องคอมพิวเตอร์ และอุปกรณ์ท่ีเกี่ยวข้อง 
  1) เกณฑ์การปฏิบัติงาน : ภาคปฏิบัติผ่านเกณฑ์ร้อยละ 80 
  2) วิธีการประเมิน : การทดสอบภาคความรู้และความสามารถ 
  3) หลักฐานการประเมิน (Performance Evidence) : แบบประเมินภาคปฏิบัติ 
  4) หลักฐานความรู้ (Knowledge Evidence) : แบบประเมินภาคความรู้ 
การทดสอบความสามารถ 
 การทดสอบความรูและความสามารถที่จำเป็นจะตองนําไปใชในการปฏิบัติงานอย่างถูกตอง ตามหลัก
วิชาการ โดยใชข้อสอบแบบปรนัย 4 ตัวเลือก จำนวน 5 ขอ ใชเวลาในการทดสอบ 1 ชั่วโมง (60 นาที) คิดเป็น
รอ้ยละ 20 ของคะแนนทั้งหมด 
การทดสอบความสามารถ  
 เป็นการทดสอบความสามารถที ่เก ิดจากการสะสมประสบการณจนเกิดความชํานาญเพียงพอ             
ที่จะปฏิบัติงานได้อย่างมีคุณภาพและมีทัศนคติในการทำงาน ตามขอกำหนดของมาตรฐานฝมือแรงงาน
แห่งชาติ ซึ่งในแบบทดสอบจะวัดประเมิน การใชเครื่องมือ อุปกรณ์การทำงานที่ถูกตองตามขั้นตอน ประหยัด 
ปลอดภัย และเสร็จทันตามเวลาที่กำหนด โดยลักษณะของแบบทดสอบจะเป็นการทดสอบทักษะฝมือโดยให้  
ผู้เขารับการทดสอบ ปฏิบัติงานตามรูปแบบและกฎเกณฑในวิธีการทดสอบมาตรฐานฝมือแรงงานแหงชาติ   
สาขาอาชีพช่างเทคนิคเขียนแบบเครื่องกล ระดับ 1 เริ่มตั้งแต่การสเก็ตช (Sketch) แบบงานจากชิ้นงานจริง 
และการเขียนแบบดด้วยโปรแกรมคอมพิวเตอร์ (ไม่จํากัดโปรแกรมที่ใช) ใชเวลาทดสอบทั้งสิ ้น 3 ชั่วโมง      
คิดเป็นร้อย 80 ของคะแนนทั้งหมด 



 2.2 บูรณาการกลุ่มอาชีพ ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 
3.  สมรรถนะประจำหน่วย 

3.17 คำสั่งเขียนแบบภาพ 3 มิติ 
3.18 การควบคุมมุมมองมาตรฐานของชิ้นงาน 
3.19 การใช้คำสั่งของโหมดฟีทเจอร์ 
3.20 การเขียนแบบ 3 มิติรูปทรงปริซึม (Prism) 
3.21 การเขียนแบบล้อสายพาน (Pulley) 
3.22 การเขียนเกลียวเพลาและเกลียวสี่เหลี่ยมคางหมู (Shaft) 

4.  จุดประสงค์การเรียนรู้ 
4.5 ด้านความรู้  ผู้เรียนสามารถ 

4.5.1 บอกชื่อคำสั่งเขียนแบบภาพ 3 มิติได้ 
4.5.2 บอกวิธีการทำงานควบคุมมุมมองมาตรฐานของชิ้นงานได้ 
4.5.3 ใช้คำสั่งของโหมดฟีทเจอร์ได้ 
4.5.4 เขียนแบบชิ้นงาน 3 มิติรูปทรงปริซึม (Prism) ได ้
4.5.5 เขียนแบบล้อสายพาน (Pulley) ได ้
4.5.6 เขียนเกลียวเพลาและเกลียวสี่เหลี่ยมคางหมู (Shaft) ได ้

 4.2 ด้านทักษะ ผู้เรียนสามารถ 
  เขียนแบบชิ้นงาน 3 มิติ ได ้
 4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       ประยุกต์ใช้ความรู้เกี่ยวกับการเขียนแบบภาพ 3 มิติ ได้ถูกต้องตามหลักการ 
 4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
  มีความสนใจใฝ่รู้ในการปฏิบัติงาน ซื่อสัตย์ ตรงเวลา รอบคอบ มีระเบียบวินัยในการทำงาน และ
ประยุกตใ์ช้ความรู้ตามหลักปรัชญาของเศรษฐกิจพอเพียงได ้ 
5.  สาระการเรียนรู้   

5.18 ชุดคำสั่งเขียนแบบภาพ 3 มิติ 
5.19 วิวทูลบาร์ (View Toolbar)  
5.20 การใช้คำสั่งของโหมดฟีทเจอร์ 
5.21 การเขียนแบบ 3 มิติรูปทรงปริซึม (Prism) 
5.22 การเขียนแบบล้อสายพาน (Pulley) 
5.23 การเขียนแบบเกลียวเพลาและเกลียวสี่เหลี่ยมคางหมู (Shaft) 

6.  กิจกรรมการเรียนรู้ 
 6.1 ขั้นนำเข้าสู่บทเรียน 

 1. ครูผู ้สอนแนะนำจุดมุ่งหมายที่ผู ้เรียนจะได้จากหลักสูตร โดยกำหนดให้ผู ้เรียนทุกคนต้องมี
ความรู้ ความสามารถและมีทักษะในเรื่อง การเขียนแบบภาพ 3 มิติ 

 2.  ครูผู้สอนทบทวนความรู้เดิมของผู้เรียนเกี่ยวกับการเขียนแบบภาพ 3 มิติ ให้ผู้เรียนแสดงความ
คิดเห็นเกี่ยวกับการเขียนแบบภาพ 3 มิติ พร้อมให้ผู้เรียนยกตัวอย่าง 
   3.  ครูผู้สอนชี้ให้เห็นความสำคัญของคอมพิวเตอร์ช่วยในการออกแบบมีต่องานอาชีพ  
 6.2 ขั้นให้เนื้อหาและการสอน 



ครูผู้สอนให้เนื้อหา โดยใช้สื่อนำเสนอ Power Point ประกอบการบรรยาย เรื่อง การเขียนแบบภาพ 3 มิติ 
6.7 ขั้นสรุปและการประยุกต์ 

13. ครูผู้สอนและนักศึกษาร่วมกันอภิปรายสรุปเนื้อหา หน่วยการเรียนที่ 5 การเขียนแบบภาพ 3 มิติ  
14. ให้ผู้เรียนทำแบบฝึกหัด ใบงาน และแบบทดสอบหลังเรียน หน่วยการเรียนที่ 5 เรื่อง การเขียน

แบบภาพ 3 มิติ 
15. ครูผู้สอนตรวจประเมินผล แบบฝึกหัด และแบบทดสอบหลังเรียน ใบงาน หน่วยการเรียนที่ 5 เรื่อง การเขียน

แบบภาพ 3 มิติ 
7.  ส่ือการเรียนการสอน 

7.9  หนังสือเรียนวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ (SolidWorks) 
7.10  สื่อนำเสนอ Power Point เรื่อง การเขียนแบบภาพ 3 มิติ 

8.  กิจกรรมเสนอแนะ / งานที่มอบหมาย  
 ผู้เรียนจัดทำใบงาน และทำกิจกรรมที่กำหนดไว้  
 8.1  แบบฝึกหัดท้ายบทเรียนที่ 5 
 8.2  แบบทดสอบหลังเรียนบทเรียนที่ 5 
9. การวัดและประเมินผล 
 9.1 เครื่องมือประเมิน 
  การสังเกตพฤติกรรมการทำงานกลุ่ม งานจากแบบฝึกหัด  คะแนนจากการทดสอบ 
 9.2 เกณฑ์การประเมิน 
  ผลรวมของคะแนนจากเครื่องมือประเมินทุกประเภทไม่ต่ำกว่าร้อยละ 60 ถือว่าผ่านเกณฑ์ประเมินผล 
 
 
  



 

แผนการจัดการเรียนรู้ที่  6 หน่วยที่ 6 
สอนครั้งที ่8-9 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพประกอบและภาพถอด
ประกอบ 

ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. 

ชื่อเรื่อง ............................................................. 
 
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

7. ใช้งานคำสั่งประกอบชิ้นงานได้ 
8. ใช้งานคำสั่งกำหนดความสัมพันธ์ชิ้นงานสามมิติได้ 
9. ประยุกต์ใช้หลักการประกอบชิ้นงานได้ 
10. เขียนแบบชิ้นงานตัวอย่างได้ 
11. ประกอบชิ้นงานตามที่กำหนดได้ 
12. สร้างแบบถอดประกอบได้ 
13. สร้างเส้นประกอบชิ้นงานได้ 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 2.1 มาตรฐานอาชีพ มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน รหัส 0920082091203 
อาชีพช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 ประกอบด้วยหน่วยสมรรถนะดังนี้ 
  0920920401 การติดตั้งโปรแกรม CAD และการจัดการข้อมูล 
  0920920402 ความรู้เบื้องต้นเกี่ยวกับการอ่านและเขียนแบบเครื่องกล 
  0920920403 การเขียนแบบ 2 มิติ 
  0920920404 การสร้างตารางรายการ (Title Block) 
  0920920405 การพิมพ์แบบงานด้วยโปรแกรม CAD 
  0920920406 การบำรุงรักษาเครื่องคอมพิวเตอร์ และอุปกรณ์ท่ีเกี่ยวข้อง 
  1) เกณฑ์การปฏิบัติงาน : ภาคปฏิบัติผ่านเกณฑ์ร้อยละ 80 
  2) วิธีการประเมิน : การทดสอบภาคความรู้และความสามารถ 
  3) หลักฐานการประเมิน (Performance Evidence) : แบบประเมินภาคปฏิบัติ 
  4) หลักฐานความรู้ (Knowledge Evidence) : แบบประเมินภาคความรู้ 
การทดสอบความสามารถ 
 การทดสอบความรูและความสามารถที่จำเป็นจะตองนําไปใชในการปฏิบัติงานอย่างถูกตอง ตามหลัก
วิชาการ โดยใชข้อสอบแบบปรนัย 4 ตัวเลือก จำนวน 5 ขอ ใชเวลาในการทดสอบ 1 ชั่วโมง (60 นาที) คิดเป็น
รอ้ยละ 20 ของคะแนนทั้งหมด 
การทดสอบความสามารถ  
 เป็นการทดสอบความสามารถที ่เก ิดจากการสะสมประสบการณจนเกิดความชํานาญเพียงพอ             
ที่จะปฏิบัติงานได้อย่างมีคุณภาพและมีทัศนคติในการทำงาน ตามขอกำหนดของมาตรฐานฝมือแรงงาน
แห่งชาติ ซึ่งในแบบทดสอบจะวัดประเมิน การใชเครื่องมือ อุปกรณ์การทำงานที่ถูกตองตามขั้นตอน ประหยัด 
ปลอดภัย และเสร็จทันตามเวลาที่กำหนด โดยลักษณะของแบบทดสอบจะเป็นการทดสอบทักษะฝมือโดยให้  
ผู้เขารับการทดสอบ ปฏิบัติงานตามรูปแบบและกฎเกณฑในวิธีการทดสอบมาตรฐานฝมือแรงงานแหงชาติ   
สาขาอาชีพช่างเทคนิคเขียนแบบเครื่องกล ระดับ 1 เริ่มตั้งแต่การสเก็ตช (Sketch) แบบงานจากชิ้นงานจริง 



และการเขียนแบบดด้วยโปรแกรมคอมพิวเตอร์ (ไม่จํากัดโปรแกรมที่ใช) ใชเวลาทดสอบทั้งสิ ้น 3 ชั่วโมง      
คิดเป็นร้อย 80 ของคะแนนทั้งหมด 
 2.2 บูรณาการกลุ่มอาชีพ ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 
3.  สมรรถนะประจำหน่วย 

3.23 ใช้คำสั่งประกอบชิ้นงาน 
3.24 ใช้คำสั่งกำหนดความสัมพันธ์ 
3.25 หลักการประกอบชิ้นงาน 
3.26 การเขียนแบบชิ้นงานตัวอย่าง 
3.27 ขั้นตอนการประกอบชิ้นงานตัวอย่าง 
3.28 การแสดงภาพถอดประกอบ 
3.29 การสร้างเส้นประกอบชิ้นงาน 

4.  จุดประสงค์การเรียนรู้ 
4.6 ด้านความรู้  ผู้เรียนสามารถ 

4.6.1 อธิบายคำสั่งประกอบชิ้นงานได้ 
4.6.2 กำหนดความสัมพันธ์ชิ้นงานสามมิติได้ 
4.6.3 อธิบายหลักการประกอบชิ้นงานได้ 
4.6.4 เขียนแบบชิ้นงานตัวอย่างได้ 
4.6.5 ประกอบชิ้นงานได้ 
4.6.6 สร้างแบบถอดประกอบได ้
4.6.7 สร้างเส้นประกอบชิ้นงานได้ 

 4.2 ด้านทักษะ ผู้เรียนสามารถ 
  เขียนแบบชิ้นงาน ประกอบชิ้นงาน สร้างแบบถอดประกอบได้ 
 4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       ประยุกต์ใช้ความรู้เกี่ยวกับการเขียนแบบภาพประกอบและภาพถอดประกอบ ได้ถูกต้องตาม
หลักการ 
 4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
  มีความสนใจใฝ่รู้ในการปฏิบัติงาน ซื่อสัตย์ ตรงเวลา รอบคอบ มีระเบียบวินัยในการทำงาน และ
ประยุกตใ์ช้ความรู้ตามหลักปรัชญาของเศรษฐกิจพอเพียงได ้ 
5.  สาระการเรียนรู้   

5.24 ชุดคำสั่งประกอบชิ้นงาน (Assembly Tab) 
5.25 การกำหนดความสัมพันธ์สำ หรับการประกอบชิ้นงาน (Mate) 
5.26 วิธีการใช้งานคำสั่งกำหนดความสัมพันธ์ 
5.27 หลักการประกอบชิ้นงาน 
5.28 แบบงานตัวอย่าง ชิ้นงานปากกาจับงาน (Vise) 
5.29 ขั้นตอนการประกอบชิ้นงาน 
5.30 การแสดงภาพถอดประกอบ (Exploded View) 
5.31 ชิ้นส่วนมาตรฐาน (Standard Part)  

6.  กิจกรรมการเรียนรู้ 
 6.1 ขั้นนำเข้าสู่บทเรียน 



 1. ครูผู ้สอนแนะนำจุดมุ่งหมายที่ผู ้เรียนจะได้จากหลักสูตร โดยกำหนดให้ผู ้เรียนทุกคนต้องมี
ความรู้ ความสามารถและมีทักษะในเรื่อง การเขียนแบบภาพประกอบและภาพถอดประกอบ 

 2.  ครูผู ้สอนทบทวนความรู้เดิมของผู้เรียนเกี่ยวกับการเขียนแบบภาพประกอบและภาพถอด
ประกอบ ให้ผู้เรียนแสดงความคิดเห็นเกี่ยวกับการเขียนแบบภาพประกอบและภาพถอดประกอบ พร้อมให้
ผู้เรียนยกตัวอย่าง 
   3.  ครูผู้สอนชี้ให้เห็นความสำคัญของคอมพิวเตอร์ช่วยในการออกแบบมีต่องานอาชีพ  
 6.2 ขั้นให้เนื้อหาและการสอน 

ครูผ ู ้สอนให้เนื ้อหา โดยใช้ส ื ่อนำเสนอ Power Point ประกอบการบรรยาย เร ื ่อง การเขียนแบบ
ภาพประกอบและภาพถอดประกอบ 

6.8 ขั้นสรุปและการประยุกต์ 
16. ครูผ ู ้สอนและนักศึกษาร่วมกันอภิปรายสรุปเนื ้อหา หน่วยการเร ียนที่  6 การเขียนแบบ

ภาพประกอบและภาพถอดประกอบ  
17. ให้ผู้เรียนทำแบบฝึกหัด ใบงาน และแบบทดสอบหลังเรียน หน่วยการเรียนที่ 6 เรื่อง การเขียน

แบบภาพประกอบและภาพถอดประกอบ 
18. ครูผู้สอนตรวจประเมินผล แบบฝึกหัด และแบบทดสอบหลังเรียน ใบงาน หน่วยการเรียนที่ 6 เรื่อง การเขียน

แบบภาพประกอบและภาพถอดประกอบ 
7.  ส่ือการเรียนการสอน 

7.11  หนังสือเรียนวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ (SolidWorks) 
7.12  สื่อนำเสนอ Power Point เรื่อง การเขียนแบบภาพประกอบและภาพถอดประกอบ 

8.  กิจกรรมเสนอแนะ / งานที่มอบหมาย  
 ผู้เรียนจัดทำใบงาน และทำกิจกรรมที่กำหนดไว้  
 8.1  แบบฝึกหัดท้ายบทเรียนที่ 6 
 8.2  แบบทดสอบหลังเรียนบทเรียนที่ 6 
9. การวัดและประเมินผล 
 9.1 เครื่องมือประเมิน 
  การสังเกตพฤติกรรมการทำงานกลุ่ม งานจากแบบฝึกหัด  คะแนนจากการทดสอบ 
 9.2 เกณฑ์การประเมิน 
  ผลรวมของคะแนนจากเครื่องมือประเมินทุกประเภทไม่ต่ำกว่าร้อยละ 60 ถือว่าผ่านเกณฑ์ประเมินผล 
 
 
  



 

แผนการจัดการเรียนรู้ที่  7 หน่วยที่ 7 
สอนครั้งที ่10-11 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบสั่งงานการผลิต ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

1.1 ใช้คำสั่งเกี่ยวกับการสร้างแบบงานได้ 
1.2 เข้าใจขั้นตอนการสร้างกระดาษเขียนแบบได้ 
1.3 สร้างกระดาษเขียนแบบได้ 
1.4 เข้าใจหลักการเขียนแบบสั่งงานการผลิตได้ 
1.5 เขียนแบบแบบสั่งงานการผลิตได้ 
1.6 ใช้คำสั่งสร้างตารางรายการวัสดุได้ 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 2.1 มาตรฐานอาชีพ มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน รหัส 0920082091203 
อาชีพช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 ประกอบด้วยหน่วยสมรรถนะดังนี้ 
  0920920401 การติดตั้งโปรแกรม CAD และการจัดการข้อมูล 
  0920920402 ความรู้เบื้องต้นเกี่ยวกับการอ่านและเขียนแบบเครื่องกล 
  0920920403 การเขียนแบบ 2 มิติ 
  0920920404 การสร้างตารางรายการ (Title Block) 
  0920920405 การพิมพ์แบบงานด้วยโปรแกรม CAD 
  0920920406 การบำรุงรักษาเครื่องคอมพิวเตอร์ และอุปกรณ์ท่ีเกี่ยวข้อง 
  1) เกณฑ์การปฏิบัติงาน : ภาคปฏิบัติผ่านเกณฑ์ร้อยละ 80 
  2) วิธีการประเมิน : การทดสอบภาคความรู้และความสามารถ 
  3) หลักฐานการประเมิน (Performance Evidence) : แบบประเมินภาคปฏิบัติ 
  4) หลักฐานความรู้ (Knowledge Evidence) : แบบประเมินภาคความรู้ 
การทดสอบความสามารถ 
 การทดสอบความรูและความสามารถที่จำเป็นจะตองนําไปใชในการปฏิบัติงานอย่างถูกตอง ตามหลัก
วิชาการ โดยใชข้อสอบแบบปรนัย 4 ตัวเลือก จำนวน 5 ขอ ใชเวลาในการทดสอบ 1 ชั่วโมง (60 นาที) คิดเป็น
รอ้ยละ 20 ของคะแนนทั้งหมด 
การทดสอบความสามารถ  
 เป็นการทดสอบความสามารถที ่เก ิดจากการสะสมประสบการณจนเกิดความชํานาญเพียงพอ             
ที่จะปฏิบัติงานได้อย่างมีคุณภาพและมีทัศนคติในการทำงาน ตามขอกำหนดของมาตรฐานฝมือแรงงาน
แห่งชาติ ซึ่งในแบบทดสอบจะวัดประเมิน การใชเครื่องมือ อุปกรณ์การทำงานที่ถูกตองตามขั้นตอน ประหยัด 
ปลอดภัย และเสร็จทันตามเวลาที่กำหนด โดยลักษณะของแบบทดสอบจะเป็นการทดสอบทักษะฝมือโดยให้  
ผู้เขารับการทดสอบ ปฏิบัติงานตามรูปแบบและกฎเกณฑในวิธีการทดสอบมาตรฐานฝมือแรงงานแหงชาติ   
สาขาอาชีพช่างเทคนิคเขียนแบบเครื่องกล ระดับ 1 เริ่มตั้งแต่การสเก็ตช (Sketch) แบบงานจากชิ้นงานจริง 
และการเขียนแบบดด้วยโปรแกรมคอมพิวเตอร์ (ไม่จํากัดโปรแกรมที่ใช) ใชเวลาทดสอบทั้งสิ ้น 3 ชั่วโมง      
คิดเป็นร้อย 80 ของคะแนนทั้งหมด 



 2.2 บูรณาการกลุ่มอาชีพ ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 
3.  สมรรถนะประจำหน่วย 

3.30 คำสั่งเก่ียวกับการสร้างแบบงาน 
3.31 การสร้างกระดาษเขียนแบบ 
3.32 การเขียนแบบสั่งงานการผลิต 
3.33 การสร้างตารางรายการวัสดุ 

4.  จุดประสงค์การเรียนรู้ 
4.7 ด้านความรู้  ผู้เรียนสามารถ 

4.7.1 บอกชื่อคำสั่งเก่ียวกับการสร้างแบบงานได้ 
4.7.2 บอกวิธีการสร้างกระดาษเขียนแบบได้ 
4.7.3 สร้างกระดาษเขียนแบบได้ 
4.7.4 บอกหลักการเขียนแบบสั่งงานการผลิตได้ 
4.7.5 เขียนแบบแบบสั่งงานการผลิตได้ 
4.7.6 ใช้คำสั่งสร้างตารางรายการวัสดุได้ 

 4.2 ด้านทักษะ ผู้เรียนสามารถ 
  ปฏิบัติการสร้างกระดาษเขียนแบบ เขียนแบบสั่งงานการผลิต และสร้างตารางรายการวัสดุได้ 
 4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       ประยุกต์ใช้ความรู้เกี่ยวกับการเขียนแบบสั่งงานการผลิต ไดถู้กต้องตามหลักการ 
 4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
  มีความสนใจใฝ่รู้ในการปฏิบัติงาน ซื่อสัตย์ ตรงเวลา รอบคอบ มีระเบียบวินัยในการทำงาน และ
ประยุกตใ์ช้ความรู้ตามหลักปรัชญาของเศรษฐกิจพอเพียงได ้ 
5.  สาระการเรียนรู้   

5.32 ชุดคำสั่งเก่ียวกับการสร้างแบบงาน (View Layout) 
5.33 การสร้างกระดาษเขียนแบบ (Sheet Format) 
5.34 การเขียนแบบสั่งงานการผลิต 
5.35 การสร้างตารางรายการ 

6.  กิจกรรมการเรียนรู้ 
 6.1 ขั้นนำเข้าสู่บทเรียน 

 1. ครูผู ้สอนแนะนำจุดมุ่งหมายที่ผู ้เรียนจะได้จากหลักสูตร โดยกำหนดให้ผู ้เรียนทุกคนต้องมี
ความรู้ ความสามารถและมีทักษะในเรื่อง การเขียนแบบสั่งงานการผลิต 

 2.  ครูผู้สอนทบทวนความรู้เดิมของผู้เรียนเกี่ยวกับการเขียนแบบสั่งงานการผลิต ให้ผู้เรียนแสดง
ความคิดเห็นเกี่ยวกับการเขียนแบบสั่งงานการผลิต พร้อมให้ผู้เรียนยกตัวอย่าง 
   3.  ครูผู้สอนชี้ให้เห็นความสำคัญของคอมพิวเตอร์ช่วยในการออกแบบมีต่องานอาชีพ  
 6.2 ขั้นให้เนื้อหาและการสอน 

ครูผู้สอนให้เนื้อหา โดยใช้สื่อนำเสนอ Power Point ประกอบการบรรยาย เรื่อง การเขียนแบบสั่งงานการ
ผลิต 

6.9 ขั้นสรุปและการประยุกต์ 
19. ครูผู้สอนและนักศึกษาร่วมกันอภิปรายสรุปเนื้อหา หน่วยการเรียนที่  7 การเขียนแบบสั่งงานการ

ผลิต  



20. ให้ผู้เรียนทำแบบฝึกหัด ใบงาน และแบบทดสอบหลังเรียน หน่วยการเรียนที่ 7 เรื่อง การเขียน
แบบสั่งงานการผลิต 

21. ครูผู้สอนตรวจประเมินผล แบบฝึกหัด และแบบทดสอบหลังเรียน ใบงาน หน่วยการเรียนที่ 7 เรื่อง การเขียน
แบบสั่งงานการผลิต 

7.  ส่ือการเรียนการสอน 
7.13  หนังสือเรียนวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ (SolidWorks) 
7.14  สื่อนำเสนอ Power Point เรื่อง การเขียนแบบสั่งงานการผลิต 

8.  กิจกรรมเสนอแนะ / งานที่มอบหมาย  
 ผู้เรียนจัดทำใบงาน และทำกิจกรรมที่กำหนดไว้  
 8.1  แบบฝึกหัดท้ายบทเรียนที่ 7 
 8.2  แบบทดสอบหลังเรียนบทเรียนที่ 7 
9. การวัดและประเมินผล 
 9.1 เครื่องมือประเมิน 
  การสังเกตพฤติกรรมการทำงานกลุ่ม งานจากแบบฝึกหัด  คะแนนจากการทดสอบ 
 9.2 เกณฑ์การประเมิน 
  ผลรวมของคะแนนจากเครื่องมือประเมินทุกประเภทไม่ต่ำกว่าร้อยละ 60 ถือว่าผ่านเกณฑ์ประเมินผล 
 
 
  



 

แผนการจัดการเรียนรู้ที่  8 หน่วยที่ 8 
สอนครั้งที ่12-13 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพตัด ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

1.7 ใช้คำสั่งสร้างภาพตัดเต็มได้ถูกต้อง 
1.8 ใช้คำสั่งสร้างภาพตัดครึ่งได้ถูกต้อง 
1.9 ใช้คำสั่งสร้างภาพตัดเฉพาะส่วนได้ถูกต้อง 
1.10 ใช้คำสั่งสร้างภาพตัดย่อส่วนได้ถูกต้อง 
1.11 ใช้คำสั่งสร้างภาพแสดงแนวการเคลื่อนที่ได้ถูกต้อง 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 2.1 มาตรฐานอาชีพ มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน รหัส 0920082091203 
อาชีพช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 ประกอบด้วยหน่วยสมรรถนะดังนี้ 
  0920920401 การติดตั้งโปรแกรม CAD และการจัดการข้อมูล 
  0920920402 ความรู้เบื้องต้นเกี่ยวกับการอ่านและเขียนแบบเครื่องกล 
  0920920403 การเขียนแบบ 2 มิติ 
  0920920404 การสร้างตารางรายการ (Title Block) 
  0920920405 การพิมพ์แบบงานด้วยโปรแกรม CAD 
  0920920406 การบำรุงรักษาเครื่องคอมพิวเตอร์ และอุปกรณ์ท่ีเกี่ยวข้อง 
  1) เกณฑ์การปฏิบัติงาน : ภาคปฏิบัติผ่านเกณฑ์ร้อยละ 80 
  2) วิธีการประเมิน : การทดสอบภาคความรู้และความสามารถ 
  3) หลักฐานการประเมิน (Performance Evidence) : แบบประเมินภาคปฏิบัติ 
  4) หลักฐานความรู้ (Knowledge Evidence) : แบบประเมินภาคความรู้ 
การทดสอบความสามารถ 
 การทดสอบความรูและความสามารถที่จำเป็นจะตองนําไปใชในการปฏิบัติงานอย่างถูกตอง ตามหลัก
วิชาการ โดยใชข้อสอบแบบปรนัย 4 ตัวเลือก จำนวน 5 ขอ ใชเวลาในการทดสอบ 1 ชั่วโมง (60 นาที) คิดเป็น
รอ้ยละ 20 ของคะแนนทั้งหมด 
การทดสอบความสามารถ  
 เป็นการทดสอบความสามารถที ่เก ิดจากการสะสมประสบการณจนเกิดความชํานาญเพียงพอ             
ที่จะปฏิบัติงานได้อย่างมีคุณภาพและมีทัศนคติในการทำงาน ตามขอกำหนดของมาตรฐานฝมือแรงงาน
แห่งชาติ ซึ่งในแบบทดสอบจะวัดประเมิน การใชเครื่องมือ อุปกรณ์การทำงานที่ถูกตองตามขั้นตอน ประหยัด 
ปลอดภัย และเสร็จทันตามเวลาที่กำหนด โดยลักษณะของแบบทดสอบจะเป็นการทดสอบทักษะฝมือโดยให้  
ผู้เขารับการทดสอบ ปฏิบัติงานตามรูปแบบและกฎเกณฑในวิธีการทดสอบมาตรฐานฝมือแรงงานแหงชาติ   
สาขาอาชีพช่างเทคนิคเขียนแบบเครื่องกล ระดับ 1 เริ่มตั้งแต่การสเก็ตช (Sketch) แบบงานจากชิ้นงานจริง 
และการเขียนแบบดด้วยโปรแกรมคอมพิวเตอร์ (ไม่จํากัดโปรแกรมที่ใช) ใชเวลาทดสอบทั้งสิ ้น 3 ชั่วโมง      
คิดเป็นร้อย 80 ของคะแนนทั้งหมด 
 2.2 บูรณาการกลุ่มอาชีพ ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 



3.  สมรรถนะประจำหน่วย 
3.34 คำสั่งเก่ียวกับการสร้างแบบงาน 
3.35 การสร้างกระดาษเขียนแบบ 
3.36 การเขียนแบบภาพตัด 
3.37 การสร้างตารางรายการวัสดุ 

4.  จุดประสงค์การเรียนรู้ 
4.8 ด้านความรู้  ผู้เรียนสามารถ 

4.8.1 อธิบายหลักการเขียนแบบภาพตัดได้ 
4.8.2 สร้างแบบภาพตัดเต็มได้ 
4.8.3 สร้างภาพตัดครึ่งได ้
4.8.4 สร้างภาพตัดเฉพาะส่วนได้ 
4.8.5 สร้างภาพตัดย่อส่วนได้ 
4.8.6 สร้างภาพแสดงแนวการเคลื่อนที่ได้  

 4.2 ด้านทักษะ ผู้เรียนสามารถ 
  ปฏิบัติการเขียนแบบภาพตัด ภาพตัดเต็ม ภาพตัดครึ่งภาพตัด ภาพตัดย่อส่วน แสดงแนวการ
เคลื่อนที ่ 
 4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       ประยุกต์ใช้ความรู้เกี่ยวกับการเขียนแบบภาพตัด ได้ถูกต้องตามหลักการ 
 4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
  มีความสนใจใฝ่รู้ในการปฏิบัติงาน ซื่อสัตย์ ตรงเวลา รอบคอบ มีระเบียบวินัยในการทำงาน และ
ประยุกตใ์ช้ความรู้ตามหลักปรัชญาของเศรษฐกิจพอเพียงได ้ 
5.  สาระการเรียนรู้   

5.36 การเขียนแบบภาพตัด (Section View) 
5.37 การสร้างภาพตัดเต็ม (Full Section)  
5.38 การสร้างภาพตัดครึ่ง (Haft Section) 
5.39 การเขียนแบบภาพตัดเฉพาะส่วน (Broken−out Section) 
5.40 การเขียนแบบภาพตัดย่อส่วน (Convention Section) 
5.41 การเขียนแบบแสดงแนวการเคลื่อนที่ (Alternate Position View) 

6.  กิจกรรมการเรียนรู้ 
 6.1 ขั้นนำเข้าสู่บทเรียน 

 1. ครูผู ้สอนแนะนำจุดมุ่งหมายที่ผู ้เรียนจะได้จากหลักสูตร โดยกำหนดให้ผู ้เรียนทุกคนต้องมี
ความรู้ ความสามารถและมีทักษะในเรื่อง การเขียนแบบภาพตัด 

 2.  ครูผู้สอนทบทวนความรู้เดิมของผู้เรียนเกี่ยวกับการเขียนแบบภาพตัด ให้ผู้เรียนแสดงความ
คิดเห็นเกี่ยวกับการเขียนแบบภาพตัด พร้อมให้ผู้เรียนยกตัวอย่าง 
   3.  ครูผู้สอนชี้ให้เห็นความสำคัญของคอมพิวเตอร์ช่วยในการออกแบบมีต่องานอาชีพ  
 6.2 ขั้นให้เนื้อหาและการสอน 

ครูผู้สอนให้เนื้อหา โดยใช้สื่อนำเสนอ Power Point ประกอบการบรรยาย เรื่อง การเขียนแบบภาพตัด 
6.10 ขั้นสรุปและการประยุกต์ 

22. ครูผู้สอนและนักศึกษาร่วมกันอภิปรายสรุปเนื้อหา หน่วยการเรียนที่ 8 การเขียนแบบภาพตัด  



23. ให้ผู้เรียนทำแบบฝึกหัด ใบงาน และแบบทดสอบหลังเรียน หน่วยการเรียนที่ 8 เรื่อง การเขียน
แบบภาพตัด 

24. ครูผู้สอนตรวจประเมินผล แบบฝึกหัด และแบบทดสอบหลังเรียน ใบงาน หน่วยการเรียนที่ 8 เรื่อง   
การเขียนแบบภาพตัด 

7.  ส่ือการเรียนการสอน 
7.15  หนังสือเรียนวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ (SolidWorks) 
7.16  สื่อนำเสนอ Power Point เรื่อง การเขียนแบบภาพตัด 

8.  กิจกรรมเสนอแนะ / งานที่มอบหมาย  
 ผู้เรียนจัดทำใบงาน และทำกิจกรรมที่กำหนดไว้  
 8.1  แบบฝึกหัดท้ายบทเรียนที่ 8 
 8.2  แบบทดสอบหลังเรียนบทเรียนที่ 8 
9. การวัดและประเมินผล 
 9.1 เครื่องมือประเมิน 
  การสังเกตพฤติกรรมการทำงานกลุ่ม งานจากแบบฝึกหัด  คะแนนจากการทดสอบ 
 9.2 เกณฑ์การประเมิน 
  ผลรวมของคะแนนจากเครื่องมือประเมินทุกประเภทไม่ต่ำกว่าร้อยละ 60 ถือว่าผ่านเกณฑ์ประเมินผล 
 
  



 

แผนการจัดการเรียนรู้ที่  9 หน่วยที่ 9 
สอนครั้งที ่14-15 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การพิมพ์แบบงาน ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

 
1. ผลลัพธ์การเรียนรู้ระดับหน่วยการเรียน 

1.12 ปรับตั้งค่ากระดาษได้ถูกต้อง 
1.13 การปรับตั้งค่าความหนาเส้นได้ถูกต้อง 
1.14 แสดงตัวอย่างก่อนพิมพ์ได้ 
1.15 พิมพ์แบบงานได้ถูกต้อง 

2. อ้างอิงมาตรฐาน/เชื่อมโยงกลุ่มอาชีพ 
 2.1 มาตรฐานอาชีพ มาตรฐานฝีมือแรงงานแห่งชาติ กรมพัฒนาฝีมือแรงงาน รหัส 0920082091203 
อาชีพช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 ประกอบด้วยหน่วยสมรรถนะดังนี้ 
  0920920401 การติดตั้งโปรแกรม CAD และการจัดการข้อมูล 
  0920920402 ความรู้เบื้องต้นเกี่ยวกับการอ่านและเขียนแบบเครื่องกล 
  0920920403 การเขียนแบบ 2 มิติ 
  0920920404 การสร้างตารางรายการ (Title Block) 
  0920920405 การพิมพ์แบบงานด้วยโปรแกรม CAD 
  0920920406 การบำรุงรักษาเครื่องคอมพิวเตอร์ และอุปกรณ์ท่ีเกี่ยวข้อง 
  1) เกณฑ์การปฏิบัติงาน : ภาคปฏิบัติผ่านเกณฑ์ร้อยละ 80 
  2) วิธีการประเมิน : การทดสอบภาคความรู้และความสามารถ 
  3) หลักฐานการประเมิน (Performance Evidence) : แบบประเมินภาคปฏิบัติ 
  4) หลักฐานความรู้ (Knowledge Evidence) : แบบประเมินภาคความรู้ 
การทดสอบความสามารถ 
 การทดสอบความรูและความสามารถที่จำเป็นจะตองนําไปใชในการปฏิบัติงานอย่างถูกตอง ตามหลัก
วิชาการ โดยใชข้อสอบแบบปรนัย 4 ตัวเลือก จำนวน 5 ขอ ใชเวลาในการทดสอบ 1 ชั่วโมง (60 นาที) คิดเป็น
รอ้ยละ 20 ของคะแนนทั้งหมด 
การทดสอบความสามารถ  
 เป็นการทดสอบความสามารถที ่เก ิดจากการสะสมประสบการณจนเกิดความชํานาญเพียงพอ             
ที่จะปฏิบัติงานได้อย่างมีคุณภาพและมีทัศนคติในการทำงาน ตามขอกำหนดของมาตรฐานฝมือแรงงาน
แห่งชาติ ซึ่งในแบบทดสอบจะวัดประเมิน การใชเครื่องมือ อุปกรณ์การทำงานที่ถูกตองตามขั้นตอน ประหยัด 
ปลอดภัย และเสร็จทันตามเวลาที่กำหนด โดยลักษณะของแบบทดสอบจะเป็นการทดสอบทักษะฝมือโดยให้  
ผู้เขารับการทดสอบ ปฏิบัติงานตามรูปแบบและกฎเกณฑในวิธีการทดสอบมาตรฐานฝมือแรงงานแหงชาติ   
สาขาอาชีพช่างเทคนิคเขียนแบบเครื่องกล ระดับ 1 เริ่มตั้งแต่การสเก็ตช (Sketch) แบบงานจากชิ้นงานจริง 
และการเขียนแบบดด้วยโปรแกรมคอมพิวเตอร์ (ไม่จํากัดโปรแกรมที่ใช) ใชเวลาทดสอบทั้งสิ ้น 3 ชั่วโมง      
คิดเป็นร้อย 80 ของคะแนนทั้งหมด 
 2.2 บูรณาการกลุ่มอาชีพ ช่างเขียนแบบเครื่องกลด้วยคอมพิวเตอร์ ระดับ 1 
(หมายเหตุ บูรณาการทุกกลุ่มอาชีพในหลักสูตรประกาศนียบัตรวิชาชีพ พุทธศักราช 2567) 



 
3.  สมรรถนะประจำหน่วย 

3.38 คำสั่งเก่ียวกับการสร้างแบบงาน 
3.39 การสร้างกระดาษเขียนแบบ 
3.40 การพิมพ์แบบงาน 
3.41 การสร้างตารางรายการวัสดุ 

4.  จุดประสงค์การเรียนรู้ 
4.9 ด้านความรู้  ผู้เรียนสามารถ 

4.9.1 การปรับตั้งค่ากระดาษ (Page Setup) 
4.9.2 การปรับตั้งค่าความหนาเส้น (Line Thickness) 
4.9.3 การดูตัวอย่างก่อนพิมพ์ (Print Preview) 
4.9.4 การพิมพ์แบบงาน (Print)  

 4.2 ด้านทักษะ ผู้เรียนสามารถ 
  พิมพ์แบบงานได้ถูกต้อง 
 4.3 ด้านการประยุกต์ใช้ ผู้เรียนสามารถ 
       ประยุกต์ใช้ความรู้เกี่ยวกับการพิมพ์แบบงาน ได้ถูกต้องตามหลักการ 
 4.4 ด้านคุณลักษณะท่ีพึงประสงค์ ผู้เรียนสามารถ 
  มีความสนใจใฝ่รู้ในการปฏิบัติงาน ซื่อสัตย์ ตรงเวลา รอบคอบ มีระเบียบวินัยในการทำงาน และ
ประยุกตใ์ช้ความรู้ตามหลักปรัชญาของเศรษฐกิจพอเพียงได ้ 
5.  สาระการเรียนรู้   

5.42 การปรับตั้งค่ากระดาษ (Page Setup) 
5.43 การปรับตั้งค่าความหนาเส้น (Line Thickness) 
5.44 การดูตัวอย่างแบบงานก่อนพิมพ์ (Print Preview) 
5.45 การพิมพ์แบบงาน (Print) 

6.  กิจกรรมการเรียนรู้ 
 6.1 ขั้นนำเข้าสู่บทเรียน 

 1. ครูผู ้สอนแนะนำจุดมุ่งหมายที่ผู ้เรียนจะได้จากหลักสูตร โดยกำหนดให้ผู ้เรียนทุกคนต้องมี
ความรู้ ความสามารถและมีทักษะในเรื่อง การพิมพ์แบบงาน 

 2.  ครูผู้สอนทบทวนความรู้เดิมของผู้เรียนเกี่ยวกับการพิมพ์แบบงาน ให้ผู้เรียนแสดงความคิดเห็น
เกี่ยวกับการพิมพ์แบบงาน พร้อมให้ผู้เรียนยกตัวอย่าง 
   3.  ครูผู้สอนชี้ให้เห็นความสำคัญของคอมพิวเตอร์ช่วยในการออกแบบมีต่องานอาชีพ  
 6.2 ขั้นให้เนื้อหาและการสอน 

ครูผู้สอนให้เนื้อหา โดยใช้สื่อนำเสนอ Power Point ประกอบการบรรยาย เรื่อง การพิมพ์แบบงาน 
6.11 ขั้นสรุปและการประยุกต์ 

25. ครูผู้สอนและนักศึกษาร่วมกันอภิปรายสรุปเนื้อหา หน่วยการเรียนที่ 9 การพิมพ์แบบงาน  
26. ให้ผู้เรียนทำแบบฝึกหัด ใบงาน และแบบทดสอบหลังเรียน หน่วยการเรียนที่ 9 เรื่อง การพิมพ์

แบบงาน 
27. ครูผู้สอนตรวจประเมินผล แบบฝึกหัด และแบบทดสอบหลังเรียน ใบงาน หน่วยการเรียนที่ 9 เรื ่อง     

การพิมพ์แบบงาน 



7.  ส่ือการเรียนการสอน 
7.17  หนังสือเรียนวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ (SolidWorks) 
7.18  สื่อนำเสนอ Power Point เรื่อง การพิมพ์แบบงาน 

8.  กิจกรรมเสนอแนะ / งานที่มอบหมาย  
 ผู้เรียนจัดทำใบงาน และทำกิจกรรมที่กำหนดไว้  
 8.1  แบบฝึกหัดท้ายบทเรียนที่ 9 
 8.2  แบบทดสอบหลังเรียนบทเรียนที่ 9 
 
9. การวัดและประเมินผล 
 9.1 เครื่องมือประเมิน 
  การสังเกตพฤติกรรมการทำงานกลุ่ม งานจากแบบฝึกหัด  คะแนนจากการทดสอบ 
 9.2 เกณฑ์การประเมิน 
  ผลรวมของคะแนนจากเครื่องมือประเมินทุกประเภทไม่ต่ำกว่าร้อยละ 60 ถือว่าผ่านเกณฑ์ประเมินผล 
 
 
 
 
 



 

ใบความรู้ หน่วยที่ 1 
สอนครั้งที ่1-4 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ คอมพิวเตอร์ช่วยในการออกแบบ ทฤษฎี 2   ชม. 
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ใบงานที ่1.1 หน่วยที่ 1 
สอนครั้งที ่1-4 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ คอมพิวเตอร์ช่วยในการออกแบบ ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

หน่วยที่ 1 คอมพิวเตอร์ช่วยในการออกแบบ 
ตอนที่ 1 จงเลือกตอบข้อที่ถูกต้องที่สุด  
1. ข้อใดคือโปรแกรมทางด้านการออกแบบ 
 ก. SolidWorks 
 ข. NX 
 ค. Auto Pipe 
 ง. ถูกทั้งข้อ ก และ ข  
2. “CAD” มีความหมายตรงกับข้อใด  

 ก. Computer Aided Drafting  
 ข. Computer Aided Engineering 
 ค. Computer Aided Manufacturing  
 ง. Computer Aided Design 
3. “CAM” มีความหมายตรงกับข้อใด  

 ก. Computer Aided Mode 
 ข. Computer Aided Engineering 
 ค. Computer Aided Manufacturing  
 ง. Computer Aided Design  
4. ข้อใด ไม่ใช ่โครงสร้างการท างานในโปรแกรม Solid works  
 ก. Graphic Area 
 ข. Part 
 ค. Assembly 
 ง. Drawing 
5. ข้อใดไม่ใช่จุดมุ่งหมายของคอมพิวเตอร์ช่วยในการออกแบบ 
 ก. เพ่ือเพ่ิมผลผลิต 
 ข. เพ่ือลดการจ้างงาน  
 ค. สามารถน าข้อมูลจากการออกแบบไปใช้เพ่ือการผลิตต่อไปได้ 
 ง. เพ่ือลดความผิดพลาดในการออกแบบ 
6. ข้อใดคือ จุดมุ่งหมายของคอมพิวเตอร์ช่วยในการออกแบบ  
 ก. เพ่ือเพ่ิมผลผลิต 



 ข. เพ่ือเพ่ิมคุณภาพของงาน 
 ค. เพ่ือลดความผิดพลาดในการออกแบบ ก 
 ง. ถูกทุกข้อ 
7. ข้อใด ไม่ใช่ กระบวนการออกแบบ 
 ก. กำหนดนิยามของปัญหา 
 ข. การวิเคราะห์และหาหนทางที่ดีท่ีสุด 
 ค. เพ่ือลดความผิดพลาดในการออกแบบ  
 ง. การประเมินผลและการนำเสนอ 
8. ข้อใดคือความหมายของ DFMA  
 ก. การออกแบบให้มีประสิทธิภาพสูงสุดส าหรับการผลิตและการประกอบ 
 ข. การออกแบบให้มีประสิทธิภาพสูงสุดส าหรับการประกอบ 
 ค. การออกแบบให้มีประสิทธิภาพสูงสุดส าหรับการผลิตและการจัดจ าหน่าย 
 ง. การออกแบบให้มีประสิทธิภาพสูงสุดส าหรับการผลิต 
9. ข้อใดเรียงล าดับกระบวนการใช้คอมพิวเตอร์ช่วยในการออกแบบได้ถูกต้อง 

(1) ก าหนดนิยามของปัญหา 
(2) พิจารณาความต้องการหรือแนวความคิด 
(3) การน าเสนอ 
(4) การประเมินผล 
(5) การวิเคราะห์และหาหนทางที่ดีท่ีสุด 
(6) การสังเคราะห์ 

 ก. (1) – (2) – (3) – (4) – (5) – (6)  
 ข. (6) – (2) – (1) – (4) – (3) – (5)  
 ค. (2) – (1) – (6) – (5) – (4) – (3)  
 ง. (6) – (5) – (4) – (3) – (2) – (1)  
10. ข้อใดไม่ใช่องค์ประกอบของการประยุกต์ใช้คอมพิวเตอร์ช่วยออกแบบ 
 ก. การวิเคราะห์หาความเสี่ยงและผิดพลาด 
 ข. การตรวสอบและประเมินผล 
 ค. การวิเคราะห์ทางวิศวกรรม 
 ง. การเขียนแบบอัตโนมัติ 
  



 

ใบความรู้ หน่วยที่ 2 
สอนครั้งที ่2 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การใช้งานโปรแกรม SolidWorks ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 

 
 
 
 
 
 
 
 
 



 

ใบงานที ่2 หน่วยที่ 2 
สอนครั้งที ่2 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การใช้งานโปรแกรม SolidWorks ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

 

หน่วยที่ 2 การใช้งานโปรแกรม SolidWorks 
ตอนที่ 1 จงตอบคำถามต่อไปนี้ให้ถูกต้อง  
1. การเปิดโปรแกรม SolidWorks มาใช้งานมีวิธีการอย่างไร 

 ก. ดับเบิลคลิกท่ี Shortcut Icon  
 ข. คลิกท่ี Shortcut icon 
 ค. Start, All Program, Microsoft 2020 
 ง. Start, All File, SolidWorks 2020 SP0.0 
2. การเข้าใช้งานโปรแกรม SolidWorks 2020 วิธีใดสะดวกรวดเร็วที่สุด  
 ก. คลิกขวาที่ไอคอน Solid works เลือกคำสั่ง Open 
 ข. คลิก Start, All Programs, SolidWorks 2020 SPO, SolidWorks 2020 SPO 
 ค. คลิกขวาที่ไฟล์งาน Solid works เลือกคำสั่ง Open 
 ง. ทุกวิธีทั้ง ก. ข. และ ค. สะดวกท้ังหมด 
 
จากภาพ จงตอบค าถามในข้อที่ 3 - 4  

 
 
3. หมายเลข 1 (Part) คือการท างานแบบใด 

ก. เขียนแบบชิ้นงาน 3 มิติ 
ข. ประกอบชิ้นงาน 
ค. น าชิ้นส่วนมาตรฐานมาใช้งาน 
ง. สร้างแบบงาน 



4. หมายเลข 2 (Assembly) คือการท างานแบบใด 
ก. เขียนแบบชิ้นงาน 3 มิติ 
ข. ประกอบชิ้นงาน 
ค. น าชิ้นส่วนมาตรฐานมาใช้งาน 
ง. สร้างแบบงาน 

5. หมายเลข 3 (Drawing) คือการท างานแบบใด 
 ก. เขียนแบบชิ้นงาน 3 มิติ   
 ข. ประกอบชิ้นงาน 
 ค. น าชิ้นส่วนมาตรฐานมาใช้งาน  
 ง. สร้างแบบงาน 
6. จากภาพแสดงวิธีการเรียกใช้ค าสั่งของโปรแกรม SolidWorks 2020 โดยวิธีใด  
 ก. การเรียกค าสั่งจากเมนูค าสั่ง 
 ข. การเรียกค าสั่งด้วยคีย์ลัด 
 ค. การเรียกค าสั่งด้วยเมนูลัด 
 ง. การเรียกค าสั่งจากแถบเครื่องมือ  
7. การเริ่มต้นเขียนแบบใหม่ด้วยโปรแกรม SolidWorks 2020 ผู้เขียนแบบต้องเลือกหมวดการท างานใด  
 ก. Part 
 ข. Drawing  
 ค. Assembly  
 ง. Advanced  
8. การเขียนแบบชิ้นงาน 3 มิติ (Part) ผู้เขียนแบบต้องเลือกท าสิ่งใดก่อนจึงเริ่มต้นการเขียนเส้นร่าง (Sketch) 
 ก. ระนาบการท างาน (Plane)  
 ข. เลือกค าสั่งใด ๆ ในการเขียนเส้นร่าง  
 ค. ก าหนดมุมมอง (View) ในการเลือกภาพ  
 ง. เลือกค าสั่ง Sketch 
 
 
 
 
 
 
 
จากภาพ จงตอบคำถามในข้อที่ 9-12 



 
 
9. หมายเลข 1 คือชื่อคำสั่งในข้อใด 
 ก. แถบเครื่องมือ (Toolbar) 
 ข. แถบคำสั่ง (Menu Bar) 
 ค. แถบการทำงาน (Status Bar) 
 ง. ส่วนจัดการ (Command manager) 
10. หมายเลข 3 คือส่วนการทำงานในข้อใด 
 ก. มุมมอง View Orientation 
 ข. ส่วนการจัดการรูปร่างภายนอก 
 ค. ส่วนเก็บรวบรวมคำสั่งในการเขียนแบบชิ้นงาน 
 ง. ส่วนจัดการคำสั่ง (Command manager) 
11. ส่วนการทำงานหมายเลข 6 คือข้อใด 
 ก. พื้นที่ทำงาน (Graphic Area) 
 ข. พ้ืนที่เขียนแบบ 
 ค. พ้ืนที่แสดงชิ้นส่วน  
 ง. การปรับมุมมอง (View Ports)  
12. หมายเลข 5 คือข้อใด  
 ก. ส่วนจัดการคำสั่ง (Command manager) 
 ข. จุดเริ่มต้น (Origin Point) เป็นจุดอ้างอิงพิกัดตามแนวแกน X,Y,Z 
 ค. แกนอ้างอิง (Reference Trade) แสดงทิศทางของแนวแกน X,Y,Z  
 ง. การปรับมุมมอง (View Ports) เช่น เลือกด้านหน้า (Front) และด้านข้างขวา (Right) 
13. จากภาพแสดงวิธีการเรียกใช้คำสั่งใด 

 



 
 ก. การเรียกคำสั่งด้วยคีย์ลัด 
 ข. การเรียกใช้แผ่นงานใหม่ 
 ค. การเรียกคำสั่งด้วยเมนูลัด 
 ง. การเรียกคำสั่งจากแถบเครื่องมือ  
14. การเริ่มต้นเขียนแบบใหม่ด้วยโปรแกรม SolidWorks 2020 ผู้เขียนแบบต้องเลือกหมวดการทำงานใด  
 ก. Part 
 ข. Assembly 
 ค. Drawing  
 ง. Advanced  
15. ข้อใดคือการปรับตั้งค่าหน่วยวัดเซนติเมตร 
 ก. Tool>Option>Document Properties>Units>CGS 
 ข. Tool>Option>Document Properties>Units>MKS 
 ค. Tool>Option>Document Properties>Units>MMGS 
 ง. Tool>Option>Document Properties>Units>MGSS 
16. ข้อใดคือไฟล์นามสกุลของส่วนการทำงาน Part Template  
 ก. *.prtdott 
 ข. *.prtdrw 
 ค. *.prtdot 
 ง. *.prtdaw 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

ใบความรู้ หน่วยที่ 3 
สอนครั้งที ่3 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพ 2 มิติ ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 

 
 
 
 
 
 
 
 
 



 

ใบงานที ่3 หน่วยที่ 3 
สอนครั้งที ่3 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพ 2 มิติ ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

หน่วยที่ 3 การเขียนแบบภาพ 2 มิต ิ
ตอนที่ 1 จงตอบคำถามต่อไปนี้ให้ถูกต้อง  
1. ข้อใดไม่ใช่หลักการสร้างสเกตซ์ 2 มิติ  
 ก. สร้างเส้นสเกตช์ บนระนาบที่ต้องการ 
 ข. ก าหนดความสัมพันธ์ (Relations) 
 ค. ก าหนดขนาดเส้นสเกตช์ 
 ง. ก าหนดมาตราส่วน 
2. เมื่อต้องการสร้างชิ้นงาน 3 มิติ ต้องเลือกใช้ค าสั่งใด 
 ก. File>New>Model 
 ข. File>New Solid works Document 
 ค. File>New>Part 
 ง. Ctrl>Alt>N 
3. การสร้างไฟล์แบบงานใหม่เพ่ือสร้างชิ้นงาน 3 มิติ ต้องเลือกท างานหมวดใด  
 ก. Part  
 ข. Drawing  
 ค. Assembly  
 ง. Advanced  
5. ข้อใด ไม่ใช ่ขั้นตอนการเริ่มต้นสร้างสเกตซ์  
 ก. คลิกแถบ Sketch และคลิกเลือกค าสั่ง Sketch 
 ข. คลิกเลือกระนาบที่ต้องการเขียนและคลิกค าสั่ง Sketch ใน Sketch Tab 
 ค. คลิกเลือกค าสั่ง Line และเลือกระนาบที่ต้องการเขียน 
 ง. คลิกค าสั่ง 3D Sketch และเลือกระนาบที่ต้องการเขียน 
6. ข้อใดคือ นามสกุลของไฟล์ชิ้นงาน 3 มิติ (Part) ที่บันทึกด้วยโปรแกรม SolidWorks 2020  
 ก. *.drw.slddw 
 ข. *.exf 
 ค. *.asm.sldasm  
 ง. *.prt.sldprt  
 



7. ค าสั่ง Line มีลักษณะการใช้งานอย่างไร 
ก. เขียนเส้นตรง แนวตั้ง แนวนอน แนวทแยง 

 ข. เขียนเส้นตรง เส้นโค้ง 
 ค. เขียนเส้นตรงแบบต่อเนื่อง  
 ง. เขียนเส้นเอียง 
8. ข้อใดคือลักษณะการใช้งานของค าสั่ง Circle 

ก. Circle, Center Circle 
 ข. Circle, Perimeter Circle 
 ค. 3TT Circle, Center Circle 
 ง. 3T Circle, Perimeter Circle 
9. ข้อใดคือลักษณะการใช้งานของค าสั่ง Trim to closest 
 ก. การตัดเส้นโดยให้เหลือมุม 
 ข. การตัดให้มีพ้ืนที่แบบปิด 
 ค. การตัดส่วนด้านในเส้นอ้างอิง 
 ง. การตัดส่วนด้านนอกเส้นอ้างอิง 
10. ข้อใดคือลักษณะการใช้งานของค าสั่ง Trim>corner 
 ก. การตัดเส้นโดยให้เหลือมุม 
 ข. การตัดให้มีพ้ืนที่แบบปิด 
 ค. การตัดส่วนด้านในเส้นอ้างอิง 
 ง. การตัดส่วนด้านนอกเส้นอ้างอิง 
11. ค าสั่ง Add Relations หมายถึงข้อใด 
 ก. การก าหนดความสัมพันธ์ให้กับสเกตซ์ตั้งแตห่นึ่งเส้นขึ้นไป 
 ข. การก าหนดความสัมพันธ์ให้กับสเกตซ์ตั้งแต่สองเส้นขึ้นไป 
 ค. การก าหนดความสัมพันธ์ให้กับสเกตซ์ตั้งแตส่ามเส้นขึ้นไป 
 ง. การก าหนดความสัมพันธ์ให้กับสเกตซ์ตั้งแต่สี่เส้นขึ้นไป 
12. ข้อใดคือลักษณะการใช้งานค าสั่ง Add Relations>Collinear 
 ก. การบังคบัให้เส้นสเกตช์อยู่ในแนวตั้ง (แกนY) 
 ข. การบังคบัให้เส้นสเกตช์อยู่ในแนวเดียวกัน 
 ค. การบังคบัให้เส้นสเกตช์อยู่ในแนวตั้งฉาก 
 ง. การบังคบัให้เส้นสเกตช์ให้ขนาดกัน 
 
 



13. ข้อใดคือลักษณะการใช้งานค าสั่ง Add Relations>Parallel 
 ก. การบังคบัให้เส้นสเกตช์อยู่ในแนวตั้ง (แกนY) 
 ข. การบังคบัให้เส้นสเกตช์อยู่ในแนวเดียวกัน 
 ค. การบังคบัให้เส้นสเกตช์อยู่ในแนวตั้งฉาก 
 ง. การบังคบัให้เส้นสเกตช์ให้ขนาดกัน 
14. ข้อใดคือลักษณะการใช้งานค าสั่ง Add Relations>Concentric 
 ก. การบังคบัให้เส้นสเกตช์ร่วมศูนย์กัน 
 ข. การบังคบัให้เส้นสเกตช์เท่ากัน 
 ค. การบังคบัให้เส้นสเกตช์อยู่ในแนวตั้งฉาก 
 ง. การบังคบัให้เส้นสเกตช์ให้ขนาดกัน 
 
 
  



 

ใบความรู้ หน่วยที่ 4 
สอนครั้งที ่4-5 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การกำหนดขนาด ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 

 
 
 
 
 
 
 
 
 



 

ใบงานที ่4 หน่วยที่ 4 
สอนครั้งที ่4-5 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การกำหนดขนาด ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

 

หน่วยที่ 4 การกำหนดขนาด 
ตอนที่ 1 จงตอบคำถามต่อไปนี้ให้ถูกต้อง  
1.  ข้อใดคือ ค าสั่งที่ใช้ก าหนดขนาด (Smart Dimension)  
 ก. Smart Dimension 
 ข. Horizontal Dimensions 
 ค. Vertical Dimensions 
 ง. Radius Dimensions 
2. ข้อใดคือ ค าสั่งส าหรับก าหนดขนาดแนวนอน 
 ก. Smart Dimension 
 ข. Horizontal Dimensions 
 ค. Vertical Dimensions 
 ง. Radius Dimensions 
3. ข้อใดคือ ค าสั่งส าหรับก าหนดขนาดแนวตั้ง 
 ก. Smart Dimension 
 ข. Horizontal Dimensions 
 ค. Vertical Dimensions 
 ง. Radius Dimensions 
4. ข้อใดคือ ค าสั่งส าหรับก าหนดขนาดแนวทแยง 
 ก. Align Dimension 
 ข. Horizontal Dimensions 
 ค. Vertical Dimensions 
 ง. Radius Dimensions 
5. เมื่อท าการบังคับให้เส้นร่าง 2 มิติ ให้มีความสมบูรณ์แล้วที่แถบสถานะจะแสดงค าสั่งใด 
 ก. Smart Dimension 
 ข. Over define 
 ค. Under define 
 ง. Fully define 



   
  
6. เส้นร่าง 2 มิติ ทีไ่มส่มบูรณ์ แถบแสดงสถานะจะปรากฏข้อความใด 

ก. Under define 
 ข. Over define  
 ค. Fully define 
 ง. Non define 
7. เมื่อต้องการก าหนดขนาดมุม (Angle) ต้องเลือกวัตถุอย่างไร  
 ก. เลือกเส้นที่ท าต้องการก าหนดมุมทั้ง 2 เส้น  
 ข. เลือกเส้นและจุด  
 ค. เลือกจุดปลายเส้นทั้งสอง 
 ง. เลือกเส้นโค้งปิดมุม 
 
 
 
  



 

ใบความรู้ หน่วยที่ 5 
สอนครั้งที ่6-7 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพ 3 มิติ ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 

 
 
 
 
 
 
 
 
 



 

ใบงานที ่5 หน่วยที่ 5 
สอนครั้งที ่6-7 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพ 3 มิติ ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

 
ตอนที่ 1 จงตอบคำถามต่อไปนี้ให้ถูกต้อง  
1. ข้อใดคือการใช้งานค าสั่ง   
 ก.  การสร้างพื้นที่ผิวด้วยการสร้างวัตถุหมุนรอบแกนที่ก าหนด 
 ข. การตัดพ้ืนที่ผิวด้วยการสร้างวัตถุหมุนรอบแกนที่ก าหนด 
 ค. การยืดพ้ืนผิววัตถุตามแนวเส้นตรงหรือตามทิศทางที่ก าหนด 
 ง. การตัดหรือเจาะวัตถุตามแนวเส้นตรง 

2. ข้อใดคือการใช้งานค าสั่ง   
 ก.  การสร้างพื้นที่ผิวด้วยการสร้างวัตถุหมุนรอบแกนที่ก าหนด 
 ข. การตัดพ้ืนที่ผิวด้วยการสร้างวัตถุหมุนรอบแกนที่ก าหนด 
 ค. การยืดพ้ืนผิววัตถุตามแนวเส้นตรงหรือตามทิศทางที่ก าหนด 
 ง. การตัดหรือเจาะวัตถุตามแนวเส้นตรง 

3. ข้อใดคือการใช้งานค าสั่ง    
 ก. การสร้างพื้นที่ผิวด้วยการสร้างวัตถุหมุนรอบแกนที่ก าหนด 
 ข. การตัดพ้ืนที่ผิวด้วยการสร้างวัตถุหมุนรอบแกนที่ก าหนด 
 ค. การยืดพ้ืนผิววัตถุตามแนวเส้นตรงหรือตามทิศทางที่ก าหนด 
 ง. การตัดหรือเจาะวัตถุตามแนวเส้นตรง 

4. ข้อใดคือการใช้งานค าสั่ง   
 ก. การสร้างพื้นที่ผิวด้วยการสร้างวัตถุหมุนรอบแกนที่ก าหนด 
 ข. การตัดพ้ืนที่ผิวด้วยการสร้างวัตถุหมุนรอบแกนที่ก าหนด 
 ค. การยืดพ้ืนผิววัตถุตามแนวเส้นตรงหรือตามทิศทางที่ก าหนด 
 ง. การตัดหรือเจาะวัตถุตามแนวเส้นตรง 

 5. ข้อใดคือการใช้งานค าสั่ง    
 ก. การตัดพ้ืนผิวด้วยการสร้างวัตถุไปตามแนวเส้นที่ก าหนด 
 ข. การตัดพ้ืนที่ผิวด้วยการสร้างวัตถุหมุนรอบแกนที่ก าหนด 
 ค. การยืดพ้ืนผิววัตถุตามแนวเส้นตรงหรือตามทิศทางที่ก าหนด 
 ง. การสร้างพื้นผิวด้วยการสร้างวัตถุไปตามแนวเส้นที่ก าหนด 
6. ข้อใดคือการใช้งานค าสั่ง  



 ก. การตัดพ้ืนผิววัตถุตามเส้นร่างบนระนาบที่ต่างกัน 
 ข. การคัดลอกวัตถุรอบแกนอ้างอิง 
 ค. การยืดพ้ืนผิววัตถุตามแนวเส้นตรงหรือตามทิศทางที่ก าหนด 
 ง. การสร้างพื้นผิวด้วยการสร้างวัตถุไปตามแนวเส้นที่ก าหนด 
7. ข้อใดคือการใช้งานค าสั่ง  

ก. การตัดพ้ืนผิววัตถุตามเส้นร่างบนระนาบที่ต่างกัน 
 ข. การสร้างพื้นผิววัตถุตามเส้นร่างบนระนาบที่ต่างกัน 
 ค. การยืดพ้ืนผิววัตถุตามแนวเส้นตรงหรือตามทิศทางที่ก าหนด 
 ง. การสร้างพื้นผิวด้วยการสร้างวัตถุไปตามแนวเส้นที่ก าหนด 
8. ข้อใดคือการใช้งานค าสั่ง  

ก. การตัดพ้ืนผิววัตถุตามเส้นร่างบนระนาบที่ต่างกัน 
 ข. การสร้างพื้นผิววัตถุตามเส้นร่างบนระนาบที่ต่างกัน 
 ค. การยืดพ้ืนผิววัตถุตามแนวเส้นตรงหรือตามทิศทางที่ก าหนด 
 ง. การสร้างพื้นผิวด้วยการสร้างวัตถุไปตามแนวเส้นที่ก าหนด 
9. ข้อใดคือการใช้งานค าสั่ง   

ก. การคัดลอกวัตถุตามแนวแกน X, Y 
 ข. การคัดลอกวัตถุรอบแกนอ้างอิง 
 ค. การคัดลอกวัตถุด้วยการสะท้อน 
 ง. การสร้างครีบ 
10. ข้อใดคือการใช้งานค าสั่ง  

ก. การคัดลอกวัตถุตามแนวแกน X, Y 
 ข. การคัดลอกวัตถุรอบแกนอ้างอิง 
 ค. การคัดลอกวัตถุด้วยการสะท้อน 
 ง. การสร้างครีบ 
11. ข้อใดคือการใช้งานค าสั่ง  

ก. การคัดลอกวัตถุตามแนวแกน X, Y 
 ข. การคัดลอกวัตถุรอบแกนอ้างอิง 
 ค. การคัดลอกวัตถุด้วยการสะท้อน 
 ง. การสร้างครีบ 
 
 
12. การใช้ค าสั่งยืดหน้าตัดและสะท้อนวัตถุเขียนแบบชิ้นงาน 3 มิติ เหมาะกับการเขียนแบบรูปทรงแบบใด 



 ก. รูปทรงสมมาตร 
 ข. รูปทรงที่มีแกนกลาง 
 ค. รูปทรงที่มีลักษณะคดเคี้ยว 
 ง. มีรูปร่างหน้าตัดหลายรูปแบบ 
13. การใช้ค าสั่งหมุนกวาดเขียนแบบชิ้นงาน 3 มิติ เหมาะกับการเขียนแบบรูปทรงแบบ 
 ก. รูปทรงสมมาตร 
 ข. รูปทรงที่มีแกนกลาง 
 ค. รูปทรงที่มีลักษณะคดเคี้ยว 
 ง. มีรูปร่างหน้าตัดหลายรูปแบบ 
14. การใช้ค าสั่งการดึงลากหน้าตัดเขียนแบบชิ้นงาน 3 มิติ เหมาะกับการเขียนแบบรูปทรงแบบ 
 ก. รูปทรงสมมาตร 
 ข. รูปทรงที่มีแกนกลาง 
 ค. รูปทรงที่มีลักษณะคดเคี้ยว 
 ง. มีรูปร่างหน้าตัดหลายรูปแบบ 
15. การใช้ค าสั่งสร้างพ้ืนผิววัตถุตามเส้นร่างบนระนาบที่ต่างกันเขียนแบบชิ้นงาน 3 มิติ เหมาะกับการเขียน
แบบรูปทรงแบบ 
 ก. รูปทรงสมมาตร 
 ข. รูปทรงที่มีแกนกลาง 
 ค. รูปทรงที่มีลักษณะคดเคี้ยว 
 ง. มีรูปร่างหน้าตัดหลายรูปแบบ 
16. จากรูปสเกตซ์ 2 มิติ ข้อใดเป็นค าสั่งที่เหมาะสมกับการขึ้นรูปล้อสายพานให้เป็นชิ้นงาน 3 มิติ 

  
 ก. Extrude Boss/Base  
 ข. Extrude Cut  
 ค. Revolve Boss/Base 
 ง. Circular Pattern  
 
 
17. ข้อใดคือ ค าสั่งที่ใช้ตัดเส้นเพื่อท าเกลียวชิ้นงาน 3 มิติ  



 
 ก. Swept Cut 
 ข. Extrude Cut  
 ค. Lofted Cut 
 ง. Cosmetic Thread  
 
 
 
  



 

ใบความรู้ หน่วยที่ 6 
สอนครั้งที ่8-9 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพประกอบและภาพถอด
ประกอบ 

ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. 

ชื่อเรื่อง ............................................................. 
 

 
 
 
 
 
 
 
 



 

ใบงานที ่6 หน่วยที่ 6 
สอนครั้งที ่ รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพประกอบและภาพถอด
ประกอบ 

ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. 

ชื่อเรื่อง  

หน่วยที่ 6 การเขียนภาพประกอบและภาพถอดประกอบ 
ตอนที่ 1 จงตอบคำถามต่อไปนี้ใหถู้กต้อง  
1. ข้อใดคือ หมวดการประกอบชิ้นงาน 3 มิติ ในโปรแกรม SolidWorks 2020  
 ก. Part 
 ข. Assembly  
 ค. Drawing  
 ง. Sub Assembly  
2. การน าชิ้นงาน 3 มิติ เข้ามาเป็นชิ้นงานแรกในการประกอบต้องค านึงถึงข้อใดมากที่สุด 
 ก. ชิ้นงานหลักหรือฐานของเครื่อง 
 ข. ต าแหน่งของชิ้นส่วน 
 ค. หน้าที่การท างานของชิ้นส่วน 
 ง. ขนาดของชิ้นส่วน 
3. ข้อใดเป็นค าสั่งที่ใช้เรียกชิ้นส่วนเข้ามาประกอบ  
 ก. Mate  
 ข. Add Relations 
 ค. Flip Mate Alignment  
 ง. Insert Component  
4. ข้อใดคือความหมายของ “Exploded View” 
 ก. การถอดประกอบ 
 ข. ภาพถอดประกอบ 
 ค. ภาพถอดชิ้นงานบางส่วน 
 ง. ภาพประกอบบางส่วน 

4. ข้อใดคือการใช้งานค าสั่ง  
 ก. พ้ืนที่สร้างชิ้นงานใหม่ 
 ข. ใช้ส าหรับแก้ไขวัตถุท่ีอยู่ในหน้าต่างการประกอบชิ้นงาน  
 ค. เลือกไฟล์วัตถุเข้ามาในหน้าต่างการประกอบชิ้นงาน 
 ง. ใช้เคลื่อนย้ายวัตถุโดยเคลื่อนย้ายเพียงชิ้นเดียว 



 

5. ข้อใดคือการใช้งานค าสั่ง  
 ก. พ้ืนที่สร้างชิ้นงานใหม่ 
 ข. ใช้ส าหรับแก้ไขวัตถุท่ีอยู่ในหน้าต่างการประกอบชิ้นงาน  
 ค. เลือกไฟล์วัตถุเข้ามาในหน้าต่างการประกอบชิ้นงาน 
 ง. ใช้เคลื่อนย้ายวัตถุโดยเคลื่อนย้ายเพียงชิ้นเดียว 

6. ข้อใดคือการใช้งานค าสั่ง  
 ก. พ้ืนที่สร้างชิ้นงานใหม่ 
 ข. ใช้ส าหรับแก้ไขวัตถุท่ีอยู่ในหน้าต่างการประกอบชิ้นงาน  
 ค. พ้ืนที่ใช้ประกอบชิ้นงานใหม่ 
 ง. ใช้เคลื่อนย้ายวัตถุโดยเคลื่อนย้ายเพียงชิ้นเดียว 

7. ข้อใดคือการใช้งานค าสั่ง  
 ก. สร้างการเคลื่อนไหวของวัตถุส าหรับแสดงวัตถุ 
 ข. สร้างตารางแสดงส่วนประกอบย่อยของวัตถุ 
 ค. เคลื่อนย้ายหรือหมุนชิ้นส่วนให้เป็นภาพถอดประกอบ 
 ง. สร้างเส้นเชื่อมต่อชิ้นส่วนของภาพถอดประกอบ 

8. ข้อใดคือการใช้งานค าสั่ง  
 ก. สร้างการเคลื่อนไหวของวัตถุส าหรับแสดงวัตถุ 
 ข. สร้างตารางแสดงส่วนประกอบย่อยของวัตถุ 
 ค. เคลื่อนย้ายหรือหมุนชิ้นส่วนให้เป็นภาพถอดประกอบ 
 ง. สร้างเส้นเชื่อมต่อชิ้นส่วนของภาพถอดประกอบ 

9. ข้อใดคือการใช้งานค าสั่ง  
 ก. สร้างการเคลื่อนไหวของวัตถุส าหรับแสดงวัตถุ 
 ข. สร้างตารางแสดงส่วนประกอบย่อยของวัตถุ 
 ค. เคลื่อนย้ายหรือหมุนชิ้นส่วนให้เป็นภาพถอดประกอบ 
 ง. สร้างเส้นเชื่อมต่อชิ้นส่วนของภาพถอดประกอบ 

10. ข้อใดคือการใช้งานค าสั่ง  
 ก. สร้างการเคลื่อนไหวของวัตถุส าหรับแสดงวัตถุ 
 ข. สร้างตารางแสดงส่วนประกอบย่อยของวัตถุ 
 ค. เคลื่อนย้ายหรือหมุนชิ้นส่วนให้เป็นภาพถอดประกอบ 
 ง. สร้างเส้นเชื่อมต่อชิ้นส่วนของภาพถอดประกอบ  



 

ใบความรู้ หน่วยที่ 7 
สอนครั้งที ่10-11 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบสั่งงานการผลิต ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 

 
 
 
 
 
 
 
 
 



 

ใบงานที ่7 หน่วยที่ 7 
สอนครั้งที ่10-11 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบสั่งงานการผลิต ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

 

หน่วยที่ 7 การเขียนแบบสั่งงานการผลิต 
ตอนที่ 1 จงตอบคำถามต่อไปนี้ให้ถูกต้อง 
1. ข้อใด ไม่ใช่ วัตถุประสงค์ของการสร้างแบบงาน (Drawing) 
 ก. เพื่อบอกขนาดของชิ้นส่วน  
 ข. เพ่ือก าหนดความหยาบละเอียดของผิว 
 ค. เพ่ือความสะดวกในการน าแบบไปใช้งาน 
 ง. เพ่ือน าแบบไปใช้ในการผลิต  
2. ข้อใดคือ การวางกระดาษแบบ Landscape  
 ก. วางแนวนอน 
 ข. วางแนวตั้ง 
 ค. วางได้ทั้งแนวตั้งและแนวนอน  
 ง. แนวตั้งกลับด้าน  
3. ข้อใดคือ การวางกระดาษแบบ Portrait 
 ก. วางแนวนอน 
 ข. วางแนวตั้ง 
 ค. วางได้ทั้งแนวตั้งและแนวนอน  
 ง. แนวตั้งกลับด้าน  
4. ค าสั่งใดใช้ส าหรับการแก้ไขตารางในกระดาเขียนแบบ 
 ก. Edit Sketch 
 ข. Edit Sheet Format 
 ค. Edit Sheet  
 ง. Edit Page 
5. ข้อใดคือ ไฟล์นามสกุลของ Drawing Template 
 ก. *.prtdot 
 ข. *.asmdot 
 ค. *.drwdot 
 ง. *.drwdrt 



 
6. Save Sheet Format เปน็ค าสั่งส าหรับการท างานใด  
 ก. การเพิ่มกระดาษ (Add Sheet) ในภายหลัง 
 ข. บันทึกไฟล์ของแบบ (Drawing) 
 ค. บันทึกไฟล์จากหมวดการสร้างชิ้นงาน 3 มิติ (3D Part)  
 ง. บันทึกไฟล์จากหมวดการประกอบ 3 มิติ (3D Assembly) 
7. ข้อใดคือวิธีการการปรับตั้งค่าตัวอักษร 

ก. Tool>Options>Document Properties- Draft Standard>Font 
 ข. Tool>Options>Document Properties>Font 
 ค. Tool>Options>Document Properties- Draft Standard>Annotations>Font 
 ง. Tool>Options>Font 
8. ข้อใดคือ ค าสั่งที่ใช้ส าหรับการวางภาพฉายทีละด้าน คือ  
 ก. Standard 3 View  
 ข. Model View  
 ค. Projection View 
 ง. Section View  
จากภาพ จงใช้ตอบค าถามข้อที่ 9 – 13 

 
9. หมายเลขใด เป็นค าสั่งใดเป็นที่ใช้ส าหรับการวางภาพฉาย 3 ด้านพร้อมกัน  
 ก. 4     ข. 5  
 ค. 6     ง. 7  
11. หมายเลขใด เป็นค าสั่งที่ใช้ส าหรับการฉายภาพ  
 ก. 1    ข. 2 
 ค. 3    ง. 4 
12. หมายเลขใด เป็นค าสั่งที่ใช้ส าหรับสร้างภาพแบบตัด 

ก. 2    ข. 3 
 ค. 4    ง. 7 
13. หมายเลขใด เป็นค าสั่งที่ใช้ส าหรับการฉายภาพแบบย่อ  

ก. 5    ข. 6 
 ค. 7    ง. 8 



 
14. ค าสั่ง Model View เป็นค าสั่งส าหรับการท างานใด 
 ก. เลือกชิ้นงาน 3 มิติ ในหมวด Part มาสร้างเป็นแบบภาพฉาย 
 ข. เป็นค าสั่งส าหรับเปิดไฟล์ชิ้นงาน 
 ค. เลือกชิ้นงานภาพประกอบเข้ามาในโหมด Drawing  
 ง. เลือกชิ้นส่วนมาตรฐาน 
15. การตัดเฉพาะส่วนต้องใช้ค าสั่งใด 
 ก. Aligned Section  
 ข. Section View 
 ค. Broken-out Section  
 ง. Detail View 
16. ค าสั่งใดเป็นค าสั่งที่สั่งให้เส้นก าหนดมีระยะห่างตามท่ีก าหนด 
 ก. Rapid Dimensioning 
 ข. Smart Dimension 
 ค. Dimension 
 ง. Vertical Dimension 
17. การใช้ค าสั่ง Project View สามารถฉายภาพได้กี่ทิศทาง 
 ก. 3 
 ข. 4 
 ค. 5 
 ง. 6 
 
 
 
 
 
 
 
 
 
  



 

ใบความรู้ หน่วยที่ 8 
สอนครั้งที ่12-13 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพตัด ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 

 
 
 
 
 
 
 
 
 



 

ใบงานที ่8 หน่วยที่ 9 
สอนครั้งที ่14-15 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การพิมพ์แบบงาน ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

หน่วยที่ 8 การเขียนแบบภาพตัด 
ตอนที่ 1 จงตอบคำถามต่อไปนี้ให้ถูกต้อง  
1. การแสดงรายละเอียดของแบบงานในส่วนที่มองไม่เห็นด้วยวิธีการใด 
 ก. การตัดชิ้นงาน  
 ข. การแสดงภาพตัด  
 ค. การเขียนแบบภาพตัด 
 ง. การสร้างพื้นที่หน้าตัด 
2. ข้อใด ไม่ใช ่ประเภทของการเขียนแบบภาพตัด 
 ก. Section View 
 ข. Full Section 
 ค. Haft Section 
 ง. Alternate Position View 
3. ข้อใดเป็นค าสั่งส าหรับการสร้างภาพตัด 
 ก. Section View 
 ข. Full Section 
 ค. Haft Section 
 ง. Alternate 
4. การก าหนดเส้นแนวตัด Cutting line จากแบบงานเลือกในค าสั่งมีการทั้งหมดก่ีวิธี 
 ก. 2 วิธ ี
 ข. 4 วิธ ี
 ค. 6 วิธ ี
 ง. 8 วิธ ี
5. จากภาพ ข้อใดคือค าสั่งส าหรับการเขียนภาพตัด 
    ก. Aligned Section  
    ข. Section View 
    ค. Broken – out Section  
    ง. Detail View 
 



6. จากภาพ เป็นการเขียนโดยใช้ค าสั่งใด 

 

ก. Standard 3 View 
ข. Project View 
ค. Broken – out Section  
ง. Auxiliary View 

 

7. จากภาพ เป็นการเขียนภาพตัดโดยใช้ค าสั่งใด 

 

 
ก. Section View 
ข. Section View Full Section 
ค. Section View Haft Section 
ง. Section View Alternate 
 

8. จากภาพ เป็นการเขียนภาพตัดด้วยค าสั่งใด 

 

ก. Break View 
ข. Project View 
ค. Broken – out Section  
ง. Broken – Section 
 

9. จากภาพ ค าสั่งใดใช้ในการเขียนภาพตัดย่อส่วน 
 

 

ก. Break View 
ข. Project View 
ค. Broken – out Section  
ง. Broken – Section 
 

10. ค าสั่งใดใช้ในการเขียนแบบแสดงการเคลื่อนที่ของชิ้นงาน  
 ก. Alternate Position View 
 ข. Alternate Position  
 ค. Alternate View 
 ง. Alternate Position Section View 



 

ใบความรู้ หน่วยที่ 9 
สอนครั้งที ่14-15 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การพิมพ์แบบงาน ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง ............................................................. 

 

 
 
 
 
 
 
 
 
 



 

ใบงานที ่9 หน่วยที่ 8 
สอนครั้งที ่12-13 รหัสวิชา 30102-2002 ชื่อวิชาเขียนแบบด้วยโปรแกรมคอมพิวเตอร์ 

ชื่อหน่วยการเรียนรู้ การเขียนแบบภาพตัด ทฤษฎี 2   ชม. 
ปฏิบัติ  3  ชม. ชื่อเรื่อง  

หน่วยที่ 9 การพิมพ์แบบงาน 
 

จงเลือกตอบคำถามถูกต้องที่สุด  
1. ข้อใดคือ คำสั่งที่ใช้ในการปรับตั้งค่ากระดาษ  
 ก. Print Setup  
 ข. Page Setup  
 ค. Print Preview 
 ง. Print  
2. การดูตัวอย่างแบบก่อนพิมพ์แบบต้องเลือกใช้คำสั่งใด  

ก. Print Setup  
 ข. Page Setup  
 ค. Print Preview 
 ง. Print  
3. การสั่งพิมพ์แบบงานข้อใดถูกต้อง  

ก. File>Print 
 ข. คลิกท่ีไอคอนเครื่องปริ้น 
 ค. Ctrl+P 
 ง. ถูกทุกข้อ 
4. จงเรียงลำดับการพิมพ์แบบงานให้ถูกต้อง 
 1) เปิดไฟล์งานที่ต้องการปริ้น 
 2)  คลิกท่ี File>Page Setup ตรวจสอบและตั้งค่าก่อนการปริ้น 
 3) เลือก Use this document setting เพ่ือเลือกเฉพาะแผ่นงานที่ต้องการปริ้น  
 4) เลือก Scale เป็น 100% เพ่ือให้ขนาดชิ้นงานที่ปริ้นออกมาได้ตามมาตราส่วนที่ต้องไว้ 
 5)  เลือก Size ขนาดกระดาษ A4 สามารถเลือกได้ทั้งแนวตั้ง (Portrait) และแนวนอน (Landscape) 
 6) กำหนดค่าการปริ้น Drawing Color เลือก Black and White สำหรับการปริ้นแบบสังงานการผลิต 
และคลิกปุ่ม OK เพ่ือจบขั้นตอน 

ก. 1-2-3-4-5-6 
 ข. 6-5-4-3-2-1 
 ค. 2-1-3-4-5-6 
 ง. ถูกทุกข้อ 
5. จากรูป ข้อใดคือการเลือกกระดาษแนวตั้ง  



 
 
ก. หมายเลข 4 

 ข. หมายเลข 5 
 ค. หมายเลข 6 
 ง. หมายเลข 7 
6. จากรูป ข้อใดคือการกำหนดให้เส้นแบบงานมีสีดำ  

 
ก. หมายเลข 4 

 ข. หมายเลข 5 
 ค. หมายเลข 6 
 ง. หมายเลข 7 
7. จากรูป ถ้าต้องการเลือกกระดาษ A3 ต้องทำการเลือกที่หมายเลขใด  



 
ก. หมายเลข 4 

 ข. หมายเลข 5 
 ค. หมายเลข 6 
 ง. หมายเลข 7 
8. ถ้าต้องการเปลี่ยนเครื่องพิมพ์ต้องทำการเลือกท่ีหมายเลขใด  

 
ก. หมายเลข 3 

 ข. หมายเลข 4 
 ค. หมายเลข 5 
 ง. หมายเลข 6 
 
 

 

 


